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This sec
HP Scan
product 
which sc

�

��


You can
menu. P
you wan
for page

������


easy way to explore the capabilities of 
resting ways you can use the scanner 
ct tour, which only takes three minutes, 
 start the HP PrecisionScan Pro 

. 

 On the Start menu, point to Programs, 
ro. Then, on the Help menu, click 
to TOC

����������	
���

tion contains the basics to help you get started with your new 
Jet scanner. From here, you can learn about viewing the 

tour, preparing items before you scan them, and choosing 
anning method to use.

�����
��
���
���
���

 print this .pdf manual using the Print command on the File 
rint the whole document, or print only the chapters or topics 
t according to their page numbers. See the table of contents 
 numbers of topics.

'
��
�������(
���

The product tour is a fast and 
the scanner and see some inte
to meet your needs. The produ
begins automatically when you
software, unless you disable it

To view the tour at other times:
and click HP PrecisionScan P
Product Tour.
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● the

● the
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● the

Where
your o

��
��

Use th

● Yo

● Yo

● Yo
the

See "S

��
��

Use th

● Yo
Ch

● Yo
pro

See "S

ther program when:

d item into an open program, such as 
ram.

are working is compliant with TWAIN. A 
ommand like Acquire Image or From 
nu such as the File menu. 
your program complies with TWAIN 
ow the command for inserting a 
umentation for the program.

rams (TWAIN)" on page 63.

�($���
!
�$�

anJet Copy Utility when you want to 
e standard copy adjustments, such as 
ning or darkening. You can also choose 
.

 menu, point to Programs, point to HP 
 Copy Utility. For help using the utility, 
Getting started

�
�����%����
�*

n start scanning from one of these places:

 scanner buttons

 HP PrecisionScan Pro software 

other program 

 HP ScanJet Copy Utility 

 you start depends on what you want to do with the scan and on 
wn preferences.

�����������
��������

e scanner buttons, which are shortcuts, when:

u want to start at the scanner.

u want to scan quickly without making changes.

u want to scan an item using the default settings optimized for 
 destination you choose.

canning from scanner buttons" on page 15.

���������
��
�
��������
��������
�

e HP PrecisionScan Pro software when:

u want to view or change a scanned image before you send it. 
anges might include resolution, cropping, or resizing.

u want to send to a destination, such as a desktop publishing 
gram, but there is no button on the scanner for that destination.

canning from HP PrecisionScan Pro" on page 31.

��
���������
�(
��
��

Start scanning from within ano

● You want to bring a scanne
your word-processing prog

● The program in which you 
program is compliant if a c
Scanner appears on a me
If you are unsure whether 
standards or you do not kn
scanned item, see the doc

See "Scanning from other prog

��
��������������+����

Start scanning from the HP Sc
make copies and need to mak
reducing or enlarging or lighte
a printer other than the default

To start the utility: on the Start
ScanJet Utilities, and click HP
click Help in the utility.
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Before p
selecting
scanner

%������

The sca

● Pap

● New

● Item
(16 l

● Gum

● Mult

● Old 

● Item

● Flatt
and 

CA

Before p
of wet g

cument feeder (ADF), which is a fast, 
le-page items, is included with some 
rdered. The ADF accepts items that 
ns:

A4-, and Legal-size paper

0 unbound pages

148.5 by 210 mm (5.8 by 8.3 inches) to 
 14 inches)

m 60 to 105 g/m2 (16 to 28 lb)

ctangular and in good condition (not 

, perforations, or punch holes

lue, correction fluid, and ink

on pages, transparencies, magazine 
d light “onionskin” pages.

DF, prepare the item by doing the 

s, paper sticky notes, and any other 

e guidelines or you cannot prepare it as 
to TOC

�
�������(
�(�

���
����

lacing items in the scanner, follow these guidelines for 
 and preparing them to prevent damage to the items and the 

.

�
�����������
��!����

nner glass can scan the widest range of items, including:

er items

s clippings, receipts, and business cards

s on all weights of media, including media lighter than 60 g/m2 
b) or heavier than 105 g/m2 (28 lb)

-backed paper

ipart forms with carbon pages

or worn photographs or documents

s containing tears, perforations, punch holes, wrinkles, or curls

er, three-dimensional items such as pages in books, fabric, 
paper with texture

UTION Avoid placing items with sharp edges in the scanner. 
Doing so can damage the scanner.

lacing an item on the scanner glass, make sure the item is free 
lue, correction fluid, or other contaminating substances.

%�������
�����",-�

The HP ScanJet automatic do
convenient way to scan multip
scanner models, or it can be o
meet the following specificatio

● Items on standard Letter-, 

● Items consisting of up to 5

● Items ranging in size from 
215.9 by 355.6 mm (8.5 by

● Items ranging in weight fro

● Items that are square or re
fragile or worn)

● Items that are free of tears

● Items that are free of wet g

Avoid multipart forms with carb
pages, gum-backed pages, an

Before placing an item in the A
following:

● Remove curls or wrinkles. 

● Remove staples, paper clip
materials from items.

If your item does not meet thes
stated, use the scanner glass.
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%����

The H
scann
scan:

● ph

● 35

● oth
siz
wi
pa

Becau
edges
Getting started

���
�����.�"

P ScanJet transparency adapter (XPA) is included with some 
er models or can be ordered. Use the XPA and its templates to 

otographic negatives

 mm slides

er transparent media up to 127 to 127 mm (5 by 5 inches) in 
e. For transparent items larger than these measurements, scan 

thout using the XPA. Just cover the item with a piece of white 
per and scan as you normally would.

se these items are easily damaged, handle them only by their 
.



Back Getting started 9
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Doing yo
same ite

● the s

● HP P

Before s

�

uch as a page from a magazine.

n the scanner glass and close the lid.

t scan using the scanner buttons" on 
to TOC

!��
���$��
��

��������

ur first scan is easy. This section shows you how to take the 
m and scan to print using the two primary scanning methods:

canner buttons 

recisionScan Pro software 

canning, you will load the item in the scanner.

��
����
	��
�	�

��
	��
������
1 Choose an item to scan, s

2 Place the item face down o

3 See "To complete your firs
page 10.
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1 Loa

on 

2 Sel
ligh
prin

3 To 
num

. The scanner scans the item using 
g this type of item and then prints the 

 using the HP PrecisionScan Pro 
r first scan using the HP PrecisionScan 
Getting started

���	�
����
����	
����
�����
	��
�������
��		���
d the item in the scanner. See "To load the item in the scanner" 
page 9.

ect COLOR COPY or B&W COPY by pressing the button until the 
t next to your choice is lit. Only select COLOR COPY if you are 
ting to a color printer.

make more than one copy, press NUMBER OF COPIES until the 
ber you want appears on the display. 

4 On the scanner, press COPY

settings optimized for printin
item to the default printer. 

If you have not already scanned
software, see "To complete you
Pro software" on page 11.

Color or B&W 
button

Number of copies button

Copy button
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��
��
�
1 Load

on p

2 With
scan
softw

3 Whe
softw
the i
wan
the o
bord

. Change the output type or make other 

can menu, click Print. 

you want and click OK. The scanner 
ding your changes, and the scanned 

d using the scanner buttons, see "To 
 the scanner buttons" on page 10.

S
bo
to TOC

��	�
����
����	
����
�����
	��
��
�������������
���
���	����
 the item in the scanner. See "To load the item in the scanner" 

age 9.

 the item loaded, press HP SCANNING SOFTWARE on the 
ner. The scanner scans the item to the HP PrecisionScan Pro 
are, choosing the best settings for this type of item.

n the scanned image appears in the preview window of the 
are, draw a selection border around the image or portion of 

mage you want. To do so, click on one corner of the area you 
t, and while holding down the mouse button, drag the cursor to 
pposite corner. Release the mouse button to complete the 
er.

4 Experiment with the image
adjustments.

5 When you finish: On the S

6 Select any printer options 
performs a final scan inclu
image prints.

If you have not already scanne
complete your first scan using

election 
rder
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This s
about 

���	

��	�

Based
optima

● ou

● res

● sh

● ex

● co

Usuall
Howev
softwa

����
	�
�����
s to scan an item by scanning in black 

graph or drawing.

, but you want a black-and-white image 
 screen.

nd white by changing the color option for 
-MAIL) you will be using. See "Changing 
4. Or, in the HP PrecisionScan Pro 

 Set Type option and choose Grayscale 
e before you scan. See "Selecting 

�

sed format, such as compressed TIFF 

 output type unless necessary. This 
nal quality for color photos or drawings, 
 sizes.

r than necessary. Generally, the 
omatically sets provides the best 
ality and small file size.

duce file size by cropping the photo to 
 final scanned image. Or, resize the 
ensions.
Getting started

����!$�������/����
���

ection contains answers to some questions users frequently ask 
scanning.

��		����
����
	��
��
�������������
���
���	����
��	

�	������
���
��
�	�

�
�����
 on the scanned item, the software automatically chooses 
l values for these settings:

tput type

olution

arpening

posure (midtones, highlights, and shadows)

lor (hue and saturation or black-and-white threshold)

y, the values the software selects provides optimal results. 
er, you can change these values in the HP PrecisionScan Pro 
re.

���
���
�
������
	��
	�
�
�	
	
You can reduce the time it take
and white when the original:

● Is a black-and-white photo

● Is a color photo or drawing
to appear on the computer

● Contains only text.

Scan color originals as black a
the scanner button (such as E
settings for buttons" on page 2
software, clear the Automatic
or a black-and-white output typ
output type" on page 36.

���
���
�
������
	��
����
����
To reduce file size:

● Save files using a compres
or JPEG.

● Avoid using the True Color
output type offers exceptio
but it also creates large file

● Set the resolution no highe
resolution the software aut
balance between image qu

● For photos, significantly re
select just one area as the
entire photo to smaller dim
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������

The HP 
almost a
you use
type of o

���	
��
A comp
(PPI). P
to displa
might pr

���	
��
Use Zoo
Zoom O

The zoo
just give
size of t

	
��������
	�!	�
ning text, you can use the text either as 
x or photo archive, or as text you can 
 have the optical character recognition 
editable automatically and send the text 
g program:

 button. Editable text appears in the 
associated with the button.

ro software, use the output type of 
xt and Image. Then on the Scan menu, 
r word-processing program, and click 
to TOC

�
������
	��
������	����
PrecisionScan Pro software sets the resolution for you. In 
ll cases, you get the best results and the smallest file size if 
 the resolution the software has determined to be best for the 
riginal you have.


	��
����������
��	����
������
���
����	
 ����	��
uter screen usually displays images at 72 to 75 pixels per inch 
rint resolution is usually higher. Screens also use fewer colors 
y an image. Even if an image looks incorrect on the screen, it 
int the way you want.


	��
����������
��	����
���
���
���
���������
m In to view an area of the scanned image close up. Use 
ut to return to the original view of the image. 

m commands do not change the final size of your scan; they 
 you a different view on a monitor. To reduce or enlarge the 
he final scan, use the Resize command on the Tools menu.

���	
��
�
����
	�
����
����
When you scan an item contai
a scanned image, such as a fa
edit. Do one of the following to
(OCR) software make the text 
to a supported word-processin

● Use the EDIT TEXT scanner
word-processing program 

● In the HP PrecisionScan P
Editable Text (OCR) or Te
click Scan To, choose you
Scan.
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�

The sca
destinat
choose.

When yo
do not v
destinat
SOFTWA

HP Prec
HP Prec

���
to TOC

�
	�������
����
	���
���������

nner buttons provide an easy way to scan items directly to 
ions or files using settings optimized for the destination you 
 

u use a scanner button except HP SCANNING SOFTWARE, you 
iew or change scanned images before they go to the 
ion or file. To view or change images, use the HP SCANNING 
RE button, which sends the scanned image to the 
isionScan Pro software. See the next chapter, “Scanning from 
isionScan Pro.”

You can change the default settings for buttons on the 
scanner. See "Changing settings for buttons" on page 24.
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01�

E-mail

Scan us
into a n

e-mail p

Choose
Choose
The ligh

Fax

Scan us
messag

Copy

Print co
Cancel
pages p

number

Choose

 ensure the best settings are used. Only use color 
ter and want a color copy. The light next to the 

hiving scanned images as files. Scanned images 

ftware to view the image or to make adjustments, 
ng.

itable form and place it in a word-processing 

tings, such as output quality, for buttons on the 
Scanning from scanner buttons


1
������������
��������

ing settings optimized for e-mail. The scanned image becomes a file inserted 
ew e-mail message.

hoto/e-mail document

 the original type before pressing E-MAIL to ensure the best settings are used. 
 E-MAIL DOCUMENT if the original contains text only or both text and graphics. 
t next to the currently selected choice is lit. 

ing settings optimized for faxing. The scanned image is inserted into a new fax 
e.

pies using settings optimized for printing. At the computer, you can click 
 to choose additional copy settings in the HP ScanJet Copy Utility before the 
rint.

 of copies

 the number of copies before pressing COPY. 

color copy/b&w copy

Choose one before pressing COPY to
copy if you are printing to a color prin
currently selected choice is lit.

File

Scan using settings optimized for arc
are saved in .pdf format.

HP Scanning Software

Scan to the HP PrecisionScan Pro so
such as changing resolution or resizi

Edit Text

Scan and then convert text into an ed
program.

more options

Open the dialog box for changing set
scanner.

e-mail document
e-mail photo

Fax
Copy

number 
of copies

color copy
b&w copy

File
HP Scanning 
Software

Edit Text

more options

E-mail
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����

Use the
optimize
program

If you ar
must sc
from HP

23��
!

When yo
using de
e-mail p
attachm
send.

���

���

����
n on the scanner glass and close the lid. 

 the ADF, see page 66.

AIL DOCUMENT by pressing the small 
ntil the light next to your choice is lit. If 
 and graphics, select E-MAIL DOCUMENT.

er.

uter prompts you for another page, do 

 pages to scan, click Done.

ges of this item, load the next page and 
 all pages are scanned. Then, click 

mail program, the scanned image 
 file attachment in a new message. 
 send it as you normally do. If the 
ttach to a new message, see "Supported 
18.
to TOC Scann

�
���/�
��!$��
���������
����������

 scanner buttons to scan quickly to a destination using settings 
d for that destination. A destination is a printer, file, or another 
, such as your e-mail, fax, and word-processing program.

e scanning slides or transparent items using the XPA, you 
an from the HP PrecisionScan Pro software. See "Scanning 
 PrecisionScan Pro" on page 31.


���������

u e-mail using the scanner button, the scanner scans the item 
fault settings optimized for mailing. If you have a supported 
rogram, the scanned image automatically appears as a file 
ent in a new e-mail message, which you then address and 

If your e-mail program is not supported, choose E-mail 
anyway. The scanner scans the item using the optimal 
settings, and the computer prompts you to save the item 
as a file. Open your e-mail program and attach the file to a 
message as you normally do.

To view the scanned item before you send it, open the file 
attachment from the new e-mail message.

��
�"
���
�
����
���

	��
���
1 Place the original face dow

Note: To load items in

2 Select E-MAIL PHOTO or E-M
button beneath the lights u
the item contains both text

3 Press E-MAIL on the scann

4 If the scanner or the comp
one of the following:

● If you do not have more

● If there are additional pa
click Scan. Repeat until
Done.

5 If you have a supported e-
automatically appears as a
Address the message and
scanned image does not a
e-mail programs" on page
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�����
Suppo
and at
autom
your e

If you 
progra
directl
promp
an e-m

To be 
in the 
you pr

See "C
which 
defaul

er buttons, the scanner scans the item 
d for faxing. If you have a supported PC 
ge then automatically appears in a new 
ddress and send. You do not make 
.

 not supported, select Fax anyway. 
the item using the optimal settings, 
mpts you to save the scanned image 
C fax program and attach the file to 
rmally do.
Scanning from scanner buttons

�	��
�"
���
������
�
rted e-mail programs allow the scanner to scan an item as a file 
taches it to a new e-mail message. If a scanned image 
atically appears as a file attachment in a new e-mail message, 
-mail program is supported.

are using an unsupported e-mail program, such as a Web-based 
m like Microsoft Hotmail®, the scanner cannot scan items 
y into an e-mail message. The scanner scans the item but then 
ts you to save it as a file. After saving the image as a file, open 
ail message and attach the file as you normally do.

prompted to save the file, make sure that E-mail file is selected 
button options. Otherwise, you receive an error message when 
ess E-MAIL at the scanner.

hanging settings for buttons" on page 24 to check or change 
e-mail program is set as the default, or to set E-mail file as the 
t.

-�&
���������

When you fax using the scann
using default settings optimize
fax program, the scanned ima
fax message, which you then a
changes to the scanned image

���
If your fax program is
The computer scans 
and the computer pro
as a file. Open your P
a message as you no
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1 Plac

Not

2 Pres

3 If the
one 

● If 

● If 
cl
D

4 If yo
auto
mes
does
prog

llow the scanner to scan items directly 
anned image automatically appears in a 
 program is supported.

d PC fax program, the scanner cannot 
essage. The scanner scans the item but 
canned image as a file. After saving the 
sage and attach the file as you normally 

, make sure that Fax file is selected in 
you receive an error message when you 

ttons" on page 24 to check or change 
s the default, or to set Fax file as the 
to TOC Scann
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e the original face down on the scanner glass and close the lid. 

e: To load items in the ADF, see page 66.

s FAX on the scanner.

 scanner or the computer prompts you for another page, do 
of the following:

you do not have more pages to scan, click Done.

there are additional pages of this item, load the next page and 
ick Scan. Repeat until all pages are scanned. Then, click 
one.

u have a supported fax program, the scanned image 
matically appears in a new fax message. Address the 
sage and send it as you normally do. If the scanned image 
 not attach to a new message, see “Supported PC fax 
rams” on this page.

������	��
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�
Supported PC fax programs a
into new fax messages. If a sc
new fax message, your PC fax

If you are using an unsupporte
scan items directly into a fax m
then prompts you to save the s
image as a file, open a fax mes
do. 

To be prompted to save the file
the button options. Otherwise, 
press FAX at the scanner.

See "Changing settings for bu
which PC fax program is set a
default.
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You ca
scann
and th
make 
printer

��
n on the scanner glass and close the lid. 

 the ADF, see page 66.

 COPY by pressing the button until the 
lit. Only select COLOR COPY if you are 
nd want a color copy.

IES by pressing the button until the 
 

r. 

pies, lighten or darken them, or change 
lick Cancel on the computer to set 
Copy Utility. Change options and click 
ncel, the number of copies specified on 
 the default printer.
Scanning from scanner buttons
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n scan an item and send it to a printer to make copies using the 
er button. At the computer, you will be able to select print quality 
e destination printer before the copies print. Note that when you 
copies, each page is treated as a separate print job, so the 
 does not collate copies. 
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����	
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1 Place the original face dow

Note: To load items in

2 Select COLOR COPY or B&W

light next to your choice is 
printing to a color printer a

3 Select the NUMBER OF COP

number you want appears.

4 Press COPY on the scanne

5 To reduce or enlarge the co
which printer prints them, c
options in the HP ScanJet 
Copy. If you do not click Ca
the scanner print directly to
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without 
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n on the scanner glass and close the lid. 

 the ADF, see page 66.

 name the file, choose a location in 
Save.

uter prompts you for another page, do 

 pages to scan, click Done.

ges of this item, load the next page and 
 all pages are scanned. Then, click 
to TOC Scann
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 scan and save items directly to files for archiving purposes 
making changes to them. The files are saved in .pdf format, 
eps the original page formatting. 

To save a scanned image in a different file format, scan to 
the HP PrecisionScan Pro software, and on the Scan 
menu, click Save As.
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���

	
1 Place the original face dow

Note: To load items in

2 Press FILE on the scanner.

3 In the Save As dialog box,
which to save it, and click 

4 If the scanner or the comp
one of the following:

● If you do not have more

● If there are additional pa
click Scan. Repeat until
Done.
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charac
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n on the scanner glass and close the lid. 

 the ADF, see page 66.

nner.

uter prompts you for another page, do 

 pages to scan, click Done.

ges of this item, load the next page and 
 all pages are scanned. Then, click 

 word-processing program, check it 
Scanning from scanner buttons
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n make text on a scanned image editable. The integrated optical 
ter recognition (OCR) program converts the text to be editable 
en places it in a supported word-processing program. Graphics 
canned image are discarded, or the OCR program might try to 
rt them and they will appear as random characters.

If a block of text appears in Microsoft Word or another 
word-processing program inside a frame you do not want, 
double-click the frame border and click Remove Frame or 
a similar command. To prevent this from happening in the 
future, see "Changing settings for buttons" on page 24.
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	��
1 Place the original face dow

Note: To load items in

2 Press EDIT TEXT on the sca

3 If the scanner or the comp
one of the following:

● If you do not have more

● If there are additional pa
click Scan. Repeat until
Done.

4 When the text opens in the
carefully for accuracy.
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accurate
proofrea
been co

These ty

● text 

● text 

● crisp

● blac

These ty

● text 

● text 

● lette
othe

● unde

● text 

Handwr

�����
�
g the OCR program appears in Microsoft 
g the settings for the EDIT TEXT button, 
different, supported program instead. 
ttons" on page 24. The Edit Text tab in 
ns dialog box will display the supported 
puter.
to TOC Scann
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haracter recognition programs convert some text more 
ly than other text. Because OCR technology is never perfect, 
d all converted text carefully to ensure the characters have 
rrectly interpreted.

pes of text convert most accurately:

in standard fonts

in 9-point font or larger

, clear text

k text on a white background

pes of text might convert less accurately:

close to non-text elements, such as bullets, lines, or graphics

in spreadsheets, tables, or forms

rs that have gaps, that “bleed” along their edges, or that touch 
r letters

rlined text 

on colored paper

iting cannot be converted.

������	��
����"����������
�
By default, text converted usin
Word or WordPad. By changin
you can have text appear in a 
See "Changing settings for bu
the HP ScanJet Button Optio
programs installed on the com
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ORE OPTIONS (if present).

t to Programs, point to HP ScanJet 
canJet Button Options.

 you want. The box in the middle of the 
at can be changed.

odify.

k OK. See "List of options for scanner 
re information.

ange any other settings for this button.

o change settings for another button.

. 
Scanning from scanner buttons
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 you use the scanner buttons, the scanner scans the item using 
s optimized for the destination, such as e-mail, that is 

iated with that button. Settings are applied to all items being 
ed until you change the settings again.

To change the settings only for the current item, you may 
want to scan using the HP PrecisionScan Pro software 
instead. See Scanning from HP PrecisionScan Pro 
(starting on page 31).
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1 Do one of the following:

● On the scanner, press M

● On the Start menu, poin
Utilities, and click HP S

2 Click the tab for the button
tab contains the settings th

3 Select a setting and click M

4 Change the setting and clic
buttons" on page 25 for mo

5 Repeat steps 3 and 4 to ch

6 Repeat steps 2 through 5 t

7 When finished, click Close



Back ing from scanner buttons 25

5
������

&"
���
'
This tab
scan us

Prompt

When Y
scan the
scan to 

When N
job will b

Dimens

Choose
If a size
example
Some sc
allows y

Quality 

Choose

● Sma

● Norm

● Larg

Output t
will be .p

which scanned images will be placed as 
ted. If no compatible e-mail programs 
you cannot scan directly to e-mail. 
e in the Destination field. Then when 
er, you will be prompted to save the 
 you can manually attach to an e-mail 

t does not appear in the list, you can try 
on the computer, which often allows the 
e e-mail program correctly. If this is a 
, check the page for this scanner on the 

support the e-mail program. Otherwise, 
on the HP website to check for known 
 want.
to TOC Scann
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 contains the scanning options that are applied to items you 
ing the E-MAIL and E-MAIL DOCUMENT scanner buttons together.

 for Another Page

es is selected, a prompt appears on the computer after you 
 first page of a job. The prompt asks if you have more pages to 
this job. 

o is selected, you will not be prompted for more pages. Each 
e treated as a single-page job.

ions of Original Document

 the size that most closely matches the item you are scanning. 
 is unavailable (grayed out), that size is not supported. For 
, this can occur if the item is larger than the scanner glass. 
anners support an optional automatic document feeder that 

ou to scan pages larger than the scanner glass.

 one:

ll file size with lower quality creates scans at 100 dpi. 

al creates scans at 200 dpi.

e file size with high quality creates scans at 300 dpi. 

ype will be Grayscale or Black & White Bitmap. The file type 
df.

Destination

Select the e-mail program into 
files when scanning is comple
are installed on the computer, 
Instead, select E-mail File her
you press E-MAIL on the scann
scanned image as a file, which
message as you normally do.

If the e-mail program you wan
to reinstall the e-mail program 
scanning software to detect th
newly released e-mail program
HP website for new drivers to 
visit the page for this scanner 
conflicts with the program you
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This ta
scan u

Autom

When
the sc

When
scann

Color

When
select
white)

Qualit

Choos

● Sm

● No

● La

For co
photos

which scanned images will be placed as 
ted. If no compatible e-mail programs 
you cannot scan directly to e-mail. 
e in the Destination field. Then when 
er, you will be prompted to save the 
 you can manually attach to an e-mail 

t does not appear in the list, you can try 
on the computer, which often allows the 
e e-mail program correctly. If this is a 
, check the page for this scanner on the 

support the e-mail program. Otherwise, 
on the HP website to check for known 
want.
Scanning from scanner buttons
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b contains the scanning options that are applied to items you 
sing the E-MAIL and E-MAIL PHOTO scanner buttons together.

atic Cropping

 Yes is selected, the scanner includes only the item or items on 
anner glass in the resulting scanned image.

 No is selected, the scanner includes the entire area of the 
er glass, including blank areas, in the resulting scanned image.

 Yes is selected, scanned images retain their color. When No is 
ed, scanned images will be black and white. No (black and 
 allows items to scan more quickly and creates smaller file sizes.

y 

e one:

all file size with lower quality creates scans at 75 dpi. 

rmal creates scans at 100 dpi.

rge file size with high quality creates scans at 150 dpi. 

lor photos, output type will be True Color. For black-and-white 
, output type will be Grayscale.

Destination

Select the e-mail program into 
files when scanning is comple
are installed on the computer, 
Instead, select E-mail File her
you press E-MAIL on the scann
scanned image as a file, which
message as you normally do.

If the e-mail program you wan
to reinstall the e-mail program 
scanning software to detect th
newly released e-mail program
HP website for new drivers to 
visit the page for this scanner 
conflicts with the program you 
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This tab
your PC

Prompt

When Y
scan the
scan to 

When N
scannin

Dimens

Choose
If a size
example
Some sc
allows y

hich scanned images will go when 
mpatible PC fax programs are installed 

can directly to a PC fax program. 
n the Destination field. Then when you 
 will be prompted to save the scanned 
 manually attach to a fax message as 

t does not appear in the list, you can try 
 on the computer, which often allows the 
e PC fax program correctly. If this is a 
, check the page for this scanner on the 

support the PC fax program. Otherwise, 
on the HP website to check for known 
 want.
to TOC Scann
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 contains the options that apply to items scanned for use with 
 fax program.

 for Another Page

es is selected, a prompt appears on the computer after you 
 first page of a job. The prompt asks if you have more pages to 
this job. 

o is selected, you will not be prompted for more pages. Each 
g job will be treated as a single-page job.

ions of Original Document

 the size that most closely matches the item you are scanning. 
 is unavailable (grayed out), that size is not supported. For 
, this can occur if the item is larger than the scanner glass. 
anners support an optional automatic document feeder that 

ou to scan pages larger than the scanner glass.

Destination 

Select the PC fax program to w
scanning is completed. If no co
on the computer, you cannot s
Instead, select Fax File here i
press FAX on the scanner, you
image as a file, which you can
you normally do.

If the PC fax program you wan
to reinstall the PC fax program
scanning software to detect th
newly released PC fax program
HP website for new drivers to 
visit the page for this scanner 
conflicts with the program you
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This ta
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you to
format

To cre
HP SC

the HP
comm

Promp

When
scan t
scan t

When
scann

Dimen

Choos
If a siz
examp
Some
allows

Color

When
select
white)

below:

lity creates scans at 100 dpi. 

00 dpi.

ality creates scans at 300 dpi. 

s selected, output type will be True 
ption is selected, output type will be 
tmap. The file type will be .pdf.
Scanning from scanner buttons
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b contains the options that apply to items you scan using the 

utton on the scanner. The File destination is intended to allow 
 archive files, so the file type used is .pdf, which keeps the 
ting of the original item and provides a relatively small file size. 

ate a file with a different file type, scan the item using the 
ANNING SOFTWARE button. Once the scanned image opens in 
PrecisionScan Pro software, save it using the Save As 

and on the Scan menu.

t for Another Page

 Yes is selected, a prompt appears on the computer after you 
he first page of a job. The prompt asks if you have more pages to 
o this job. 

 No is selected, you will not be prompted for more pages. Each 
ing job will be treated as a single-page job.

sions of Original Document

e the size that most closely matches the item you are scanning. 
e is unavailable (grayed out), that size is not supported. For 
le, this can occur if the item is larger than the scanner glass. 

 scanners support an optional automatic document feeder that 
 you to scan pages larger than the scanner glass.

 Yes is selected, scanned images retain their color. When No is 
ed, scanned images will be black and white. No (black and 
 allows items to scan more quickly and creates smaller file sizes.

Quality 

Use one of the quality options 

● Small file size with low qua

● Normal creates scans at 2

● Large file size with high qu

If the Color option on this tab i
Color. If the black-and-white o
Grayscale or Black & White Bi
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This tab
the EDIT

the OCR
process

Prompt

When Y
scan the
scan to 

When N
scannin

Dimens

Choose
If a size
example
Some sc
allows y

Flowed

When Y
in what 
option to

When N
a frame,
the origi
extensiv

gram into which the scanned image will 
mpleted. WordPad will always be 

cessing program but it does not appear 
all the program on the computer, which 

are to detect it correctly. If this is a 
k the page for this scanner on the HP 
port the program. Otherwise, visit the 
P website to check for known conflicts 
to TOC Scann
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 contains the options that are applied to items you scan using 
 TEXT scanner button. Text on these items is processed using 
 program so that the text will be editable in your word-

ing program.

 for Another Page

es is selected, a prompt appears on the computer after you 
 first page of a job. The prompt asks if you have more pages to 
this job. 

o is selected, you will not be prompted for more pages. Each 
g job will be treated as a single-page job.

ions of Original Document

 the size that most closely matches the item you are scanning. 
 is unavailable (grayed out), that size is not supported. For 
, this can occur if the item is larger than the scanner glass. 
anners support an optional automatic document feeder that 

ou to scan pages larger than the scanner glass.

 Text (Format)

es (flowed text) is selected, output is converted to one column 
the software perceives to be the most logical order. Use this 
 make more extensive changes to text. 

o, use framed text when possible is selected, text appears in 
 positioned as closely as possible to the way they appear in 
nal, for example in columns. Text can be more difficult to edit 
ely since the frames might not expand to hold additional text.

Destination

Select the word-processing pro
be placed when scanning is co
available. 

If you want a different word-pro
in the list, you can try to reinst
often allows the scanning softw
newly released program, chec
website for new drivers to sup
page for this scanner on the H
with the program you want.
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ftware provides preview capabilities and 
ome of the changes you can make 

 the preview image to become the final 
to TOC
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e HP PrecisionScan Pro software, you can preview scanned 
and make changes to the images before you send them to a 
ion or file them. You start the HP PrecisionScan Pro software 
canner button or the Programs group in the Start menu.

 also start the HP PrecisionScan Pro software from another 
, such as a word-processing or image-editing program, if the 
 is compliant with TWAIN. See "Scanning from other programs 
)" on page 63 for more information.

01�
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The HP PrecisionScan Pro so
tools for changing an image. S
include:

● select only part of, or crop,
scanned image

● change the resolution

● resize the scanned image

● change the contrast
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ftware provides several means of 

t available on computer running a 
plorer that is earlier than 4.0. For 
issues that did not generate 
1.

-by-step help as you move through the 
the Guided Steps appear along the left 
 you become more comfortable with the 
o show or hide them, on the View 

, on the toolbar click . 

ear automatically to notify you of 
le, if you are setting a very high 
e scanned image, a Smart Friend would 
bly be too large to e-mail. To turn 
 the Don’t remind me again check box in 
urn all messages off, click Disable All 
enu. To turn all messages back on, click 
Scanning from HP PrecisionScan Pro
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 Start menu, point to Programs, and click HP PrecisionScan 
he software starts.

w the function of a command, place the cursor over the 
and until an explanation appears.

ore information about the types of assistance the software itself 
 see “Finding help for using the software” on this page. For more 
ation about keyboard shortcuts, menu items, toolbars, and 
 appearance, see "Using software commands and controls" on 
05.
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The HP PrecisionScan Pro so
assisting you. 

 
(
The Online Help is no
version of Internet Ex
Help, see "Resolving 
messages" on page 8

)�����
�	���
Use the Guided Steps for step
scanning process. By default, 
side of the preview window. As
software, you can hide them. T
menu, click Guided Steps. Or

�
��	
(������
Smart Friends are tips that app
potential problems. For examp
resolution but want to e-mail th
alert you that the file will proba
individual messages off, select
the message’s dialog box. To t
Smart Friends on the Help m
Enable All Smart Friends.

Hover over a command 
in this toolbar to see an 
explanation
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To gain 
the Help
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Click 
informat
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 scanner does a preliminary scan of the 
 image in the HP PrecisionScan Pro 
e scanned image and edit it, if 
 a destination or saving it as a file.

n on the scanner glass and close the lid. 

 the ADF, see page 66.
to TOC Scanning fr

����
ne Help is an easy-to-use source of information about using 
ner and software, troubleshooting, support, and specifications. 

access to the Help: on the Help menu, click Contents. Or, click 
 button in any dialog box in which it appears.

�����
����
 and click a button, menu, or command to find more 

ion about that feature.
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Once you start a new scan, the
item and displays the scanned
software. Then, you can see th
necessary, before sending it to

��
�	��	
+���#���,
�
���
����
1 Place the original face dow

Note: To load items in
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s in the HP PrecisionScan Pro software, 
comes the final scanned image by 
n you create a selection area, a dotted 
nd the area:

arance of the cursor when it is over an 
e "Context-sensitive cursors" on 

k more closely at an area without 
 included in the final scan, see 
 (zooming)" on page 35.
Scanning from HP PrecisionScan Pro

rt the scan in one of these ways:

On the scanner, press HP SCANNING SOFTWARE.

In the HP PrecisionScan Pro software, click  on the toolbar.

In the HP PrecisionScan Pro software, click New Scan on the 
Scan menu.

If the Guided Steps are showing, click .

anned image appears in the HP PrecisionScan Pro software. 
canned image is the preview image. You can make changes, 
s selecting only part of the image or adjusting the contrast. 

 you send the image to another program such as e-mail, place 
age on a website, or save it as a file, the scanner performs a 
can of the item that includes any changes you made. Directions 
king optional adjustments and completing the scan appear in 
ction.
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Once a scanned image appear
you must select which area be
creating a selection area. Whe
selection border appears arou

For information about the appe
area of the selection border, se
page 111.

 
(
If you only want to loo
changing what will be
"Getting a closer look

selection 
border
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Do one 

● Pres

● On t

● Draw
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to look at it more closely or make 
 the entire preview image, or so you 
e image to view. Zooming in on the 
hanges or performing a final scan 

 The zoom commands are not available 
tion area.

hange which part of the image becomes 
ge the final output size (physical output 
 part of the image becomes the final 
 or selecting an area for final scan" on 
see "Resizing (output dimensions)" on 

, do one of the following:

oom in. 

oom out to return to the original view of 
to TOC Scanning fr
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of the following:

ove the cursor over the area you want and click.

hen the cursor looks like this: , click on one corner of the 
ea you want and drag the cursor to the opposite corner to 
aw a rectangular selection area.

n the Edit menu, click Select All. The entire scanner bed, 
cluding blank areas, is selected. 
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 a handle of the selection border and drag to resize.


	��
�����	���
������
e cursor over the selection area. When the cursor looks like 
, click and drag the selection border to the new location.
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of the following:

s ESC.

he Edit menu, click Unselect All.

 a selection border around a different area of the image.

	���
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Zoom in on the selection area 
changes to it. Zoom out to view
can select a different area of th
selection area before making c
provides the best final results.
if you have not created a selec

Zooming in and out does not c
the final scan, nor does it chan
dimensions). To change which
scanned image, see "Cropping
page 34. To resize the image, 
page 38.
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After creating a selection area

● On the View menu, click Z

● Click .

��
���

��	

Do one of the following:

● On the View menu, click Z
the image.

● Click .
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Use this output 
type

f shading to be:

t to millions of colors
 the .jpg or .png file 

True Color 
(16.7 million 
colors)

ing to be:

 small file size

256-Color 
(optimized palette)

ing to be printed to a Grayscale

ding to be used for any Grayscale

e placed in another 
r program.

Black & White 
Bitmap

e resized in another Black & White 
Scalable

mat and displayed on the 256-Color (web 
palette) 

ord-processing program. Editable Text 
(OCR)

raphics to be used. Text and Image

ch shading and with a 
 The image is to be used 

Spot Color (16-
color)
Scanning from HP PrecisionScan Pro
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 Automatically Set Type is selected, the scanning software 
atically chooses an output type based on the type of item you 
anning. However, you can change the output type yourself when 
ant. Choose the output type based on how you will use the final 
ed image as well as the type of item you are scanning.

�	
��
��	��	
	���
 one of the following:

If it is not already selected, click Automatically Set Type on the 
Output Type menu, to allow the software to choose the best 
output type for this type of original item. 

To change the output type only for this scan, keep 
Automatically Set Type selected and select an output type you 
want from the Output Type menu. See List of output types"List 
of output types" on page 36.

To change the output type for this scan and all other scans in 
this session, clear Automatically Set Type and select an output 
type you want from the Output Type menu. See List of output 
types"List of output types" on page 36.

If you are scanning from a TWAIN compatible application, the 
Spot Color, Black & White Scalable, Editable Text, and 
Text & Image output types are not supported and appear greyed 
out in the Output Type menu.

For help choosing an output type, view the Guided Steps. 
If they are not already displayed, click .
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For these uses

Color photos or drawings with lots o
● printed on a color printer
● displayed on a color monitor se
● displayed on Web and saved in

format

Color photos or drawings with shad
● printed to a color printer
● sent via e-mail
● used in any way that requires a
● viewed on a computer screen

Color photos or drawings with shad
B&W printer.

B&W photos and drawings with sha
purpose.

B&W drawings without shading to b
program without resizing in the othe

B&W drawings without shading to b
program.

Any image to be saved in .gif file for
Web.

Text that needs to be editable in a w

Text that needs to be editable and g

Color drawings or logos without mu
concentrated area of a single color.
for any purpose.
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often, but using any of them is still 
tput type chosen, some tools will not be 
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��	��	
	���
utput Type menu, click Automatically Set Type. The 

 chooses the best output type based on the image inside the 
 area.

4��
����(�
���!��

These tools are needed most 
optional. Depending on the ou
available.
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1 On

2 Do

●

●

Ne
se
Re

3 If y
de
ou
so
rem

ount of data in a scanned image. The 
 optimal resolution based on the output 

 does not need to change. 

, choose one no higher than the 
inter and one appropriate for the type of 
to print on a 600 dpi printer, choose 600 
ges, but choose only 200 for color or 

lutions produce optimal quality while 

r color images increases file size while 
uble the resolution, the file size 
n prevent you from doing certain tasks, 
 up too much space on your computer.

 based on the type of original item and 
image quality" on page 59.

hange Resolution.

list.

2 and 999,999 in the field and press 

n as you select a value.

nge Resolution. Then, click .
Scanning from HP PrecisionScan Pro
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n resize the image before you do the final scan by changing the 
 dimensions. Resizing the scanned image to the actual 
sions you need before performing the final scan helps ensure 
st image quality.

If you need to resize images to fit in a file, such as word-
processing document, resize them here in the scanning 
software. Resizing images in the other program may 
cause them to be fuzzy or have jagged edges.

���
��
�
���
 the Tools menu, click Resize. The Resize dialog box opens.

 one of the following:

If necessary, select a unit of measure in the Units field. In the 
Output Dimensions area, type a new value in the Width or 
Height field and press ENTER.

In the Scale field, select a scale percentage.

w values appear in the Scale, Width, and Height fields, but the 
lection area and the scanned image on screen remain the same. 
sizing occurs when you complete the scan.

ou want, click . This locks the output dimensions you 
fined so you can change the selection area without changing the 
tput dimensions. When you change the selection border, the 
ftware resizes the border proportionally. The output dimensions 

ain the same.

�����
���
���!��
���

Resolution determines the am
scanning software chooses the
type. This resolution generally

If you do change the resolution
capabilities of the monitor or pr
scanned image. For example, 
for black-and-white bitmap ima
grayscale images. These reso
keeping file sizes small.

Selecting higher resolutions fo
not increasing quality. If you do
quadruples. Large file sizes ca
such as e-mailing, or can take

For help choosing a resolution
destination, see "Tips for best 

��
������
������	���
1 On the Tools menu, click C

2 Do one of the following:

● Select a value from the 

● Type a value between 1
ENTER.

The resolution changes as soo

��
����	
������	���
On the Tools menu, click Cha
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The con
settings
on page

-degree increments clockwise or 
eed to rotate the image if you placed the 
f the scanner glass, or if the item was 
tives in their template often scan 

ise: On the Tools menu, click Rotate 
 the toolbar. Repeat to continue turning.

rclockwise: On the Tools menu, click 
on the toolbar. Repeat to continue 
to TOC Scanning fr

You can add the Reset Resolution tool to the toolbar. See 
"To add tools to the toolbar" on page 109.


�������
���

trast is controlled by the midtone, highlight, and shadow 
. See "Changing midtones" on page 43, "Changing highlights" 
44, and "Changing shadows" on page 45.

;����
������
����

You can rotate the image in 90
counterclockwise. You might n
bottom of the item at the top o
sideways. Items such as nega
sideways.

��
��	�	�
��
�
���
Do one of the following:

● To rotate an image clockw
right 90°. Or, click  on

● To rotate an image counte
Rotate left 90°. Or, click 
turning.
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You ca
axis. M
on the
particu
their te

��
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On the
layout

es detail in the image. The 
e automatically selects the optimal 
nge it.

arpening if the image looks fuzzy. 
 decrease sharpening if the original item 
asing sharpening, or increasing it too 
d create undesirable patterns. 

harpen.

 the list. The viewer shows the effect of 

harpen.

et Sharpen tool to the toolbar. See 
olbar" on page 109.
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n mirror, or reverse, an image from side to side on the vertical 
irroring an image allows you to see the elements of the image 

 opposite side of their actual position. Mirroring can be 
larly useful for items such as negatives that might be placed in 
mplate backward and scanned in reverse.

���
+��#����,
��
�
���
 Tools menu, click Mirror. Repeat to return to the original 

.

���
(��
������
����

Increasing sharpening enhanc
HP PrecisionScan Pro softwar
sharpen level, but you can cha

You might want to increase sh
Conversely, you might want to
has flaws or marks on it. Incre
much, can accent the flaws an

��
�������
��
�
���
1 On the Tools menu, click S

2 Select a sharpen level from
the changes on the image.

��
����	
�������
��#���
1 On the Tools menu, click S

2 Click .

 
(
You can add the Res
"To add tools to the to
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software
type sel
except t

��
����	
Do one 

● On t

● On t

�9��������:���1�����

e ones that most people generally do 
anced users might want them for special 
ing on the output type chosen, some 
to TOC Scanning fr
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 reset images to the optimal (default) values the scanning 
 chose for the image. Optimal values are based on the output 

ected. Resetting removes all adjustments you have made 
he output type, zoom level, or the selection area. 


���
��.��	
��	�
of the following:

he Edit menu, click Undo Editing Changes.

he toolbar, click .

4��
����(�
���!��

These optional adjustments ar
not use or need, but some adv
effects or other needs. Depend
tools are not available.
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e Invert command to convert white areas of an image to black 
ack to white. For color images, a color is converted to its 
ementary color. Generally, this command is useful for drawings 
ot color images.

��	
	��
�
���
 Advanced menu, click Invert Colors. Repeat to reverse the 

 again. 
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The mid
image. T
Moving 
image. 

To adjus
use "Ad

 
(

lick Adjust Exposure.

to the right.

 the Midtone field and press ENTER.

to the Midtone field.

lick Adjust Exposure.

to the left.

the Midtone field and press ENTER.

ext to the Midtone field.

�
lick Adjust Exposure.

dtone, highlight, and shadow to the 
nned image. Clicking Auto also returns 
s. See "Setting pixel output levels" on 
to TOC Scanning fr
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tone setting lets you lighten or darken the middle values in an 
he range for the number in the Midtone field is 1.0 to 4.0. 

toward 1.0 darkens the image. Moving toward 4.0 lightens the 

t midtones for slides, negatives, or other transparent items, 
justing midtones for transparent items" on page 73.

If you are sharing the image with others who will be 
viewing it on a computer screen, the Midtone value 2.2 is 
recommended because it is an average value that works 
with many different monitors. 

��
����	��
	��
�
���
�#�����

1 On the Advanced menu, c

2 Do one of the following:

● Drag the Midtone slider 

● Type a higher number in

● Click the Up arrow next 

��
������
	��
�
���
�#�����
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Midtone slider 

● Type a lower number in 

● Click the Down arrow n

��
��	���
	�
	��
������	
��		���
1 On the Advanced menu, c

2 Click Auto to return the mi
default settings for this sca
output levels to the default
page 47.

Midtone set at 2.2
(the default)

Midtone set at 3.0
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The hi
screen
white.

The im
makes
areas.
distinc

To adj
use "A

���

lick Adjust Exposure.

 toward the right.

 the Highlights field and press ENTER.

ext to the Highlight field.

��
lick Adjust Exposure.

 toward the left.

the Highlights field and press ENTER.

to the Highlight field.

����	
#����
hen the cursor changes to the 

rea you want to be the highlight and 

�
lick Adjust Exposure.

dtone, highlight, and shadow to the 
nned image. Clicking Auto also returns 
s. See "Setting pixel output levels" on 

H
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ghlight is the value in the image that is represented on the 
 as white. All values lighter than the highlight also appear as 

 

age has a default highlight setting. Selecting a higher number 
 more of the lighter values distinct, which increases detail in light 
 Selecting a lower number makes fewer of the lighter values 
t, which reduces detail in the light areas. 

ust highlights for slides, negatives, or other transparent items, 
djusting highlights for transparent items" on page 73.

��
��������
��	���
��
����	��
��
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Highlight slider

● Type a higher number in

● Click the Down arrow n

��
������
��	���
��
����	��
���
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Highlight slider

● Type a lower number in 

● Click the Up arrow next 

��
������
�
#����
��
	��
����
Click  (white eyedropper). W
eyedropper, move it over the a
click.

��
��	���
	�
	��
������	
��		���
1 On the Advanced menu, c

2 Click Auto to return the mi
default settings for this sca
output levels to the default
page 47.

ighlights set at 218 Highlights set at 122
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The sha
as black

The ima
makes m
dark are
values d

To adjus
use "Ad

����

lick Adjust Exposure.

r toward the right.

 the Shadows field and press ENTER.

ext to the Shadows field.

����
lick Adjust Exposure.

r toward the left.

the Shadows field and press ENTER.

to the Shadows field.

�
#����
When the cursor changes to the 
rea you want to be the shadow and 

�
lick Adjust Exposure.

dtone, highlight, and shadow to the 
nned image. Clicking Auto also returns 
s. See "Setting pixel output levels" on 
to TOC Scanning fr
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dow is the value in the image that is represented on the screen 
. All values darker than the shadow also appear as black.

ge has a default shadows value. Selecting a higher number 
ore of the darker values distinct, which increases detail in 

as. Selecting a lower number makes fewer of the darker 
istinct, which reduces detail in the dark areas. 

t shadows for slides, negatives, or other transparent items, 
justing shadows for transparent items" on page 74.

��
��������
��	���
��
������
�
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Shadows slide

● Type a higher number in

● Click the Down arrow n

��
��������
��	���
��
������
�
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Shadows slide

● Type a lower number in 

● Click the up arrow next 

��
�����	
�
#����
��
	��
�����
Click  (black eyedropper). 
eyedropper, move it over the a
click.

��
��	���
	�
	��
������	
��		���
1 On the Advanced menu, c

2 Click Auto to return the mi
default settings for this sca
output levels to the default
page 47.

Shadow set at 10 Shadow set at 3
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The lig
detail 
highlig
therefo
satura
have n

You ca
contai

���	
+��������	,
�����
lick Adjust Exposure.

. The light areas in the image that will 
pear black.

lick the Up arrow repeatedly until the 
m the image. The result of the change 
 image.

 Highlight Alarm off.

���
+������,
�����
lick Adjust Exposure.

. The darker areas in the image that will 
il) appear white.

k the Down arrow repeatedly until the 
m the image. The result of the change 

 Shadow Alarm off.

N
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htest or darkest areas of an image that will print without any 
in them are known as clipped areas. The lightest areas, or 
hts, will print as the color of the paper (without ink or toner) and 
re will have no detail. The darkest areas, or shadows, will print 

ted in the blackest color of ink or toner, and therefore will also 
o detail. 

n view and change clipped areas if you want those areas to 
n detail when they print.

��
#���
���
������
�������
�
1 On the Advanced menu, c

2 Click  (Highlight Alarm)
print as white (no detail) ap

3 In the Highlights setting, c
clipped pixels disappear fro
can be seen in the preview

4 Click  again to turn the

��
#���
���
������
�������
�
1 On the Advanced menu, c

2 Click  (Shadow Alarm)
print as black (without deta

3 In the Shadow setting, clic
clipped pixels disappear fro
can be seen.

4 Click  again to turn the

ormal view View when 
Highlight 
Alarm 
selected

View when 
Shadow 
Alarm 
selected
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The outp
pictures
levels ap

Decreas
Increasi
Changin
value to

To chan
see the 

 
(

lick Adjust Exposure.

heck box. The dialog box expands to 
nd Black output levels.

ne of the following:

ide of a slider.

 in the White or Black field and press 

rrow next to the White field or Black 

utput levels can be seen in the preview 

�
lick Adjust Exposure.

dtone, highlight, shadow, and output 
s for this scanned image.
to TOC Scanning fr
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ut levels setting lets you create interesting effects for scanned 
. When you select this command, the Black and White output 
pear. By default, white is set to 255, and black is set to 0. 

ing the White output level makes the overall image darker. 
ng the Black output level makes the image more faded. 
g the White output level value to 0 and the Black output level 
 255 inverts the colors in the image. 

ge the ranges for the numbers in the White and Black fields, 
Controls tab of "Setting preferences" on page 60.

To use an image as a light background for dark text, such 
as for an overhead transparency, increase the Black 
output level until the image is as faint as you want. 
To use an image as a dark background for light text, such 
as for color slides, decrease the White output level value 
until the image is as dark as you want.

��
������
��	��	
��#���
1 On the Advanced menu, c

2 Click the Output Levels c
display the current White a

3 To change the levels, do o

● Click on the line at one s

● Type a different number
ENTER.

● Click the Up or Down a
field.

The result of the changes to o
area.

��
��	���
	�
	��
������	
��		���
1 On the Advanced menu, c

2 Click Auto to return the mi
levels to the default setting
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You ca
graysc

To vie
transp
page 7

��
#���
1 On

2 Cl

3 Mo
ap

N

4 Cl
the

e distribution of pixels in the selection 
ents the current setting for shadow. The 
setting for highlight. The midtone setting 

he histogram when either eyedropper 
age. This line shows you where in the 
a of the image occur.

l distribution in the preview image, not in 
ging the selection area changes the 
g for highlight or shadow does not 

Highlight

Where pixels in the 
image under the 
eyedropper fall
Scanning from HP PrecisionScan Pro
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n view the RGB values and pixel color for any spot in a color or 
ale image using the RGB meter.

w the RGB values and pixel color for slides, negatives, or other 
arent items, use "Viewing RGB values and pixel color" on 
4.


	��
%)/
#�����
���
��!���
 the Advanced menu, click Adjust Exposure.

ick  or .

ve the pointer over the image. The RGB values and pixel color 
pear in the RGB meter.

ote: Do not click while the eyedropper pointer is over the 
image unless you want to change the setting for 
highlight or shadow.

ick the same eyedropper button again. The RGB meter dims and 
 cursor returns to normal.

"����������
����
��

The histogram is a graph of th
area. The magenta line repres
red line represents the current 
is not represented. 

The turquoise line appears in t
cursor is positioned over the im
histogram the pixels in that are

The histogram represents pixe
the final scanned image. Chan
histogram. Changing the settin
change the histogram. 

RGB 
values Pixel 

color

Shadow
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Color in
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The soft
might w
want to 
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1 On t

2 Cha
imag
on th

● D
ar

● C
ou

The resu
the imag

 
(

��
��	��
1 On t

2 Click
this 

ts hue and the saturation. Saturation 
lors. 

n for an image, but you can change it. 
 make colors in the image more or less 
ect. The range in the Saturation field is 

lick Adjust Color.

 doing one of the following:

lider.

 the Saturation field and press ENTER.

to the Saturation field.

lick Adjust Color.

oing one of the following:

der.

the Saturation field and press ENTER.

ext to the Saturation field.

�
lick Adjust Color.

default hue and saturation settings for 
to TOC Scanning fr
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 an image consists of its hue and the saturation. Hue refers to 
all color cast of the image. 

ware sets the hue for an image, but you can change it. You 
ant to change it if the image has too much of one color, or if you 
create a special effect.

��
	��
���

he Advanced menu, click Adjust Color.

nge the overall color of the 
e by doing one of the following 
e color wheel:

rag the indicator circle to a new 
ea.

lick the arrow for a color on the 
ter edge of the wheel.

lt of the change can be seen in 
e.

If the image has too much of one color, move toward the 
color’s opposite. 

�
	�
	��
������	
��		����
he Advanced menu, click Adjust Color.

 Auto to return to the default hue and saturation settings for 
scanned image.

�����
�����������
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��

Color in an image consists of i
refers to the intensity of the co

The software sets the saturatio
You might want to change it to
vivid, or to create a special eff
0 to 150. 

��
��������
��	���	���
1 On the Advanced menu, c

2 Make colors more vivid by

● Click to the right of the s

● Type a higher number in

● Click the Up arrow next 

��
��������
��	���	���
1 On the Advanced menu, c

2 Make colors less vivid by d

● Click to the left of the sli

● Type a lower number in 

● Click the Down arrow n

��
��	���
	�
	��
������	
��		���
1 On the Advanced menu, c

2 Click Auto to return to the 
this scanned image.

Indicator circle

Arrows
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Chang
Black 
image
in the 
values

The im
zero m
makes
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hite Bitmap is selected on the Output 
should have a dot beside it.

lick Adjust Black & White Threshold.

 field and press ENTER.

rrow next to the field.

mage. This can be especially useful if 
black-and-white photograph. See 
 page 40.

����
lick Adjust Black & White Threshold.

(
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ing black-and-white threshold only applies to images using the 
& White Bitmap output type. The threshold is a value in the 
 that represents the border between black and white. All values 
image that are lighter than the threshold appear as white, and all 
 darker appear as black.

age has a default threshold value. Choosing a number closer to 
akes more values appear as white. Choosing a higher number 
 more values appear as black. 

��
������
�����"���"���	�
	�
1 Make sure that Black & W

Type menu. The selection 

2 On the Advanced menu, c

3 Do one of the following:

● Drag the slider.

● Type a new value in the

● Click the Up or Down a

4 If necessary, sharpen the i
the original was a color or 
"Sharpening an image" on

��
����	
�����"���"���	�
	����
1 On the Advanced menu, c

2 Click Auto.

Threshold at 127 
the default for this image)

Threshold at 45
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hite Bitmap is selected on the Output 
should have a dot beside it.

lick Adjust Black & White Threshold.

 the Scan using channel list.

the red in the image to white. Green and 
ful for originals printed on pink or red 

e the green in the image to white. Red 
 Useful for originals printed on green 

 the blue in the image to white. Red and 
eful for originals printed on blue paper.

onvert light shades of all colors to white 
lors to black. (No one color becomes all 

s are converted to gray at a ratio of 30% 
 blue.

hite Bitmap is selected on the Output 
should have a checkmark beside it.

lick Adjust Black & White Threshold.

the Scan using channel list.
to TOC Scanning fr
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cedure only applies to color images that will be using the Black 
 Bitmap output type. It allows you to create special effects, or to 
or originals on colored paper.

consist of pixels. In color images, each pixel has a varying 
of Red, Green, or Blue to create its specific color. You can 
e whether the Red, Green, or Blue in each pixel turns to black 

 in the final scanned image.

��
��	
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�
�
1 Make sure that Black & W

Type menu. The selection 

2 On the Advanced menu, c

3 Select a color channel from

● Choose Red to change 
blue become black. Use
paper.

● Choose Green to chang
and blue become black.
paper.

● Choose Blue to change
green become black.Us

● Choose NTSC Gray to c
and dark shades of all co
white or all black.) Color
red, 59% green, and 11%

��
����	
	�
	��
������	
������
1 Make sure that Black & W

Type menu. The selection 

2 On the Advanced menu, c

3 Choose NTSC Gray from 
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newsp

Note t
are no
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turn it 

�

timal (default) values the scanning 
Optimal values are based on the output 
es all adjustments you have made 

evel, or the selection area.

do Editing Changes.
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e Descreen command to reduce undesirable patterns in printed 
that you are scanning. An example of an undesirable pattern is a 
pattern, or the circles that often appear on pictures printed in 
apers.

hat scanning takes longer when this command is selected. If you 
t scanning a printed original, turn Descreen off to reduce 
ing time.

�����
�
����
 Advanced menu, click Descreen. Select the option again to 
off.

;�����
����!!���9�������

You can reset images to the op
software chose for the image. 
type selected. Resetting remov
except the output type, zoom l

��
����	
���
��.��	
��	�
Do one of the following:

● On the Edit menu, click Un

● On the toolbar, click . 
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When yo
by doing

● Sen

● Retu

● Savi

● Prin

● Plac

● Sett

● Cop

● Drag

● Drag
page

When yo
scan inc
you cho

Images 
them to 
another 
See "Sa

hanging the scanned image, you can 
it directly to a program such as e-mail. If 
ailable, save the image as a file and 
gram as you normally would.

rd or another word-processing 
appears inside a frame you do not 
 frame border and click Remove 
mmand. To prevent this from 
re, see "Setting preferences" on 

k Scan To.

ided Steps (if visible), click .

e list and click Scan. 

ccepts multipage files, you might be 
ges to scan to this file. Do one of the 

, click Done.

of this item, load the next page in the 
on the computer. Repeat until all pages 
 Done.

s and displays the scanned image.
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u finish making changes, you need to complete the final scan 
 one of these tasks:

ding to a program. See this page.

rning the image to a TWAIN program. See page 54.

ng to a file. See page 54.

ting. Seepage 56.

ing a scan on a website. Seepage 56.

ing the scanned image as wallpaper. See page 57.

ying and pasting into another program. Seepage 57.

ging-and-dropping into another program. Seepage 57.

ging-and-dropping to the Windows Desktop or a folder. See 
58.

u do any of these procedures, the scanner performs a final 
luding your changes before sending it to the program or printer 
ose, copying the image, etc. 

are not automatically saved as files if you print them, send 
a another program, or copy and paste them into a file in 
program. To use the scanned image again, be sure to save it. 
ving to a file" on page 54.
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Once you finish viewing and c
perform a final scan and send 
the program you want is not av
insert it into the destination pro

 
(
If you send text to Wo
program and the text 
want, double-click the
Frame or a similar co
happening in the futu
page 60.
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1 Do one of the following:

● On the Scan menu, clic

● On the toolbar or the Gu

2 Choose a program from th

3 If the program you select a
asked if you have more pa
following:

● If this is a one-page item

● If there are more pages 
scanner and click Scan 
are scanned. Then, click

The destination program open
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If you 
perfor
proced
"Scan
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Do on

● On

● On

when you want to use the images again 
h file type to use, see "List of file types" 
st image quality" on page 59. For 
e "Glossary" on page 113.

k Save As. 

.

Steps, if they are visible.

t of file types" on page 55.

 for the file and click OK. 

ailable, more options are available for 
, change any options you want, and 

s on how you will use the file. And, some 
n certain output types are selected. 
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started the scan from a TWAIN-compliant program, you can 
m a final scan and return the image to that program using this 
ure. For more information about scanning using TWAIN, see 

ning from other programs (TWAIN)" on page 63.
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e of the following:

 the Scan menu, click Return image to 

 the toolbar, click .
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Save scanned images as files 
later. For help deciding on whic
on page 55, or see "Tips for be
definitions of File types, see th
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1 Do one of the following:

● On the Scan menu, clic

● On the toolbar, click 

● Click  in the Guided 

2 Select a file type. See "Lis

3 Select a name and location

4 If the Options button is av
this file type. Click Options
click OK.

The file type you need depend
file types are not available whe
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Image f

● Bitm
mos

● Flas
seve
Flas
auto
editi
256-

● GIF 
that 
used

● JPE
stren
adva
an im
data
an a
or on
You 
on a
othe
allow
prefe

● PNG
GIF.
the v
deco
outp

 by scanners, TIFF files are widely 
t work with photographs and other 
mapped graphic (also called a raster 
solution. TIFF image files can be used 

mpressed TIFF files for images are 
 files.

X file format is for images used in 
s PC Paintbrush and Paint.

he Microsoft Windows Metafile file 
 (vector) images in Windows programs. 
es using the Black & White Scalable 

rmats 

ful for text and graphics that will be 
 Web. When this format is selected for a 
 both text and images, the text is 
nd is saved as HTML, and the graphics 
 files.

t useful for text, photos, and drawings. 
r to view .pdf files. If no changes need to 
 type is useful for sharing (as through e-
 its generally small file size.

at can be used with a page that 
tures. The formatting of text in an .rtf file 

d then interpreted by other programs.

at for saving only the text in the 
ou are using the Editable Text (OCR) 
itable, unformatted, ASCII text.
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ile formats 

ap (.bmp). Often a good choice because Windows itself and 
t Windows programs accept the .bmp file type.

hPix (.fpx). A FlashPix file contains a complete image plus 
ral lower resolution copies of that image. The advantage of the 
hPix file format over other file formats is that a program can 
matically select the best resolution for a particular job to make 
ng and using images faster and easier. Cannot be used with 
color output types.

(.gif). GIF is a compressed file format suitable for an image 
will be used on the Web or on multiple platforms. Cannot be 
 with True Color output type.

G (.jpg). JPEG is a compressed file format for images. Its 
gths are small file sizes and speed. The trade-off for these 
ntages, though, is reduced image quality. Because each time 
age is compressed with JPEG it loses a little of the image 

, avoid compressing a file with JPEG more than once. JPEG is 
ppropriate file format for an image that will be used on the Web 
 multiple platforms. 

can save your JPEG file as a progressive JPEG. When used 
 Web page, a progressive JPEG is initially sent as just every 
r line, with the remaining lines sent immediately after. This 
s a (somewhat blurry) image to display sooner. Most people 
r this. Cannot be used with 256-color output types.

 (.png). A compressed image file format that might replace 
 Like GIF, PNG uses non-lossy compression, which means all 
isual data is saved and restored when the file is 
mpressed. Unlike GIF, PNG can be used with the true color 
ut type, as well as grayscale ones.

● TIFF (.tif). Usually created
accepted by programs tha
images. A TIFF file is a bit
graphic) and can be any re
on multiple platforms.

● TIFF compressed (.tif). Co
smaller than standard TIFF

● PCX image (.pcx). The PC
Windows programs such a

● Windows Metafile (.wmf). T
format is used for scalable
It is only available for imag
(vector) output type.

Text or text-and-image file fo

● HTML (.htm). HTML is use
viewed on the World Wide
scanned image containing
converted to editable text a
are saved as GIF or JPEG

● PDF (.pdf). PDF is a forma
Use Adobe Acrobat Reade
be made to the file, this file
mail) and filing because of

● Rich Text (.rtf). The .rtf form
contains text or text and pic
can usually be retained an

● Text (.txt). Use .txt file form
selection area and when y
output type. Text will be ed
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The se
select
blank 

The P
select
Bitma

Printin
image
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1 Do

●

●

●

2 In 

�
��

e by scanning directly to the Web. 
 photos and other items by visiting your 
dress you can give them. Links to the 

tion for the first time, you will be 
 website. Then, you can scan directly to 

 scan on a site other than an 
, save the scanned image as a file 
 on the site as you normally do.

k Scan To.

.

Steps, if they are visible.

rom the list and click Scan.

he screen to finish posting the scanned 
Scanning from HP PrecisionScan Pro
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lection area is the part of the image that prints. If there is no 
ion border, the contents of the entire scanner bed, including 
areas, print. 

rint command is disabled if one of these output types is 
ed: Editable Text (OCR), Text and Image, or Black and White 
p Scalable. To print, you must select a different output type.

g does not save the image to the computer. Save the scanned 
 to a file to use the image later.

	
 one of the following:

On the Scan menu, click Print.
On the toolbar, click .

Click  in the Guided Steps, if they are visible.

the Print dialog box, select the options you want and click OK.
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Share photos with other peopl
People you know can view the
website, which will have an ad
website are in English.

When you choose this destina
prompted to sign up for the free
the site whenever you want.

 
(
If you want to place a
HP Share-to-Web site
and then place the file
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1 Do one of the following:

● On the Scan menu, clic

● On the toolbar, click 

● Click  in the Guided 

2 Select HP Share-to-Web f

3 Follow the instructions on t
image to the website.
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When yo
and use
Right-cli

To chan
and click
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You can
into a fil
become
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1 In th

● O

● O

2 In th
inse

3 Cho
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ned image into another program if that 
op. The cursor turns to a  if you try to 
rogram that does not support drag-and-
over a program or area that does not 

�
������

n program. Make sure you can see both 
d the HP PrecisionScan Pro software.

ro software, place the cursor over the 

rea and drag to the location in the 
, release the mouse button. Wait for the 
scan of the image.
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u choose this command, the software performs the final scan 
s the results as the wallpaper on your Windows Desktop. 
ck on the scanned image and click Set as Wallpaper.

ge to a different wallpaper, right-click on the Windows Desktop 
 Properties.
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 copy the scanned image to the Clipboard and then paste it 
e in the destination program. After the image is pasted, it 
s a part of the file.
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e HP PrecisionScan Pro software, do one of the following:

n the Edit menu, click Copy.

n the toolbar, click .

e destination program, place the cursor where you want to 
rt the scanned image and click. 

ose the Paste command in the program.

,
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You can drag-and-drop a scan
program supports drag-and-dr
drop a scanned image into a p
drop, or if you drag the image 
support drag-and-drop.
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1 Open a file in the destinatio

the destination program an

2 In the HP PrecisionScan P
scanned image.

3 Click inside the selection a
destination program. Then
scanner to perform a final 
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Scann
folder 
given 
scann
There
drag-a
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1 Ma

an

2 In 
sc

3 Pr

4 W
the
sc
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g from HP PrecisionScan Pro” provide 
you need to scan items every day. In 
ation about:

t the best image quality. (See "Tips for 
e 59.)

tings you use all the time and use them 
 select them. (See "Saving settings" on 

settings the scanner uses to scan all 
ences" on page 60.)

 programs compliant with TWAIN. (See 
rams (TWAIN)" on page 63.)

o expect from the OCR program, see 
grams" on page 23.
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ed images you drag-and-drop to the Windows Desktop or a 
in Windows Explorer become a bitmap file. The bitmap file is 
a generic name such as “scan.bmp.” Subsequent images 
ed to the Desktop or that folder replace the current one. 
fore, if you want to save a scanned image, rename it before you 
nd-drop another image to that location.
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ke sure you can see both the HP PrecisionScan Pro software 
d the Desktop or the folder you want in Windows Explorer.

the HP PrecisionScan Pro software, place the cursor over the 
anned image.

ess CTRL and click over the selection area.

hile holding down the mouse button, drag the scanned image to 
 Desktop or folder and release the mouse button. Wait until the 

anner performs the final scan.
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The other sections in “Scannin
the most common information 
this section, you can find inform

● which settings to use to ge
best image quality" on pag

● how to save a group of set
with future scans when you
page 59.)

● how to change the default 
items. (See "Setting prefer

● how to start scanning from
"Scanning from other prog

For information about results t
"What to expect from OCR pro
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Output t
determin

When yo
output ty
want to 

● "To s

● "Cha

● "List

 
(

 
(

p of settings that you frequently use for 
 them to items you scan in the future. 
-mail pictures to someone, you can save 
ut type, resolution, and dimensions that 
re automatically applied when you scan 

p of settings.

fault settings and any changes you 
nges you make after that point are 

age whose settings you want to save is 
 that you have adjusted any settings for 

o Settings, and click Save. The settings 
age appear.

 bottom, type a name for these settings 

ecisionScan Pro software.

o Settings, and click Load. 

s you want from the list at the bottom 
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ype, resolution, file type, and values for other controls 
e image quality and file size.

u first scan an item, the scanner chooses the defaults for 
pe and resolution, and you do not need to change them. If you 

change these settings or want help choosing a file type, see:

elect an output type" on page 36

nging resolution" on page 38

 of file types" on page 55

For help choosing the best output type for your image, use 
the Guided Steps. To show them, click  on the toolbar.

For any image that will be printed, choose TIF 
compressed as the file type to reduce the file size while 
maintaining quality. Also, many different programs 
recognize this file type.
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You can save and name a grou
a particular purpose and apply
For example, if you routinely e
the settings including the outp
you always use. The settings a
a picture and choose the grou

Saved settings override the de
made up to that point. Any cha
preserved.
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1 Make sure the scanned im

in the preview window and
the image.

2 On the Scan menu, point t
for the current scanned im

3 In the drop-down list at the
and click Save.

��
���
��		����
1 Scan an item to the HP Pr

2 On the Scan menu, point t

3 Select the group of setting
and click Load.
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The pr
chang
option
adjust

��
��	

1 On

2 Cl

3 Ch
de

4 W

ences dialog box controls these 

ning Software button is pushed 

e scan appears when you press the 
on the scanner. When cleared, the 
r does not scan. You will start a scan 

o software. 

ality scaling is applied to the final scan. 
scaling is applied, making scanning 

ality sharpening is applied to the final 
uality sharpening is applied, making 

el bit depth is acquired from the scanner 
mage. When cleared, less image data is 
aster. 

ise in the image caused by the scanner. 
 is not applied, making scanning faster.

ialog 

ppears during final scanning that asks 
 this item to scan. When cleared, the 
nly one page. Applies only to .pdf, .txt, 
Scanning from HP PrecisionScan Pro
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eferences are the default settings for all scans performed. To 
e a setting only for the item currently being scanned see "Making 
al adjustments, basic" on page 37 and "Making optional 
ments, advanced" on page 41.
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 the Scan menu, click Preferences.

ick the tab you want.

ange any settings you want. See the next sections for 
scriptions of options on tabs.

hen finished, click OK.

�������
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The Scanner tab of the Prefer
options.

Preview scan when HP Scan

When selected, a preview of th
HP Scanning Software button 
software starts, but the scanne
from the HP PrecisionScan Pr

Best Quality Scaling 

When selected, the highest qu
When cleared, normal quality 
faster.

Best Quality Sharpening 

When selected, the highest qu
scan. When cleared, normal q
scanning faster.

Maximum Pixel Depth 

When selected, the largest pix
to produce the highest quality i
processed, making scanning f

Noise Reduction 

When selected, reduces the no
When cleared, noise reduction

Enable Scan Another Page D

When selected, a dialog box a
you if there are more pages of
scanner assumes each job is o
and .rtf formats.
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The Sel

Automa

When se
which yo

Automa

When s
of the ar

Automa

When se
controls
Thresho
new sele
different
Thresho

When c
controls

Automa

When s
controls
you crea
different

When c
controls

e default resolution values available 
n the Tools menu. 

, but you can add custom resolution 
esolutions that do not appear here, 200 
he Resolution dialog box. These values 
y are the recommended values for 
ages.

 999,999. Click Add to add a value. Or, 
 to delete that value. 

es dialog box controls the following 
put from the OCR program.

xt from the page into frames and 
ge formatting as closely as possible to 
hich the text is placed must support this 

lumn and other formatting and inserts 
losely as possible to where they were in 

uage the OCR program uses to check 
m.
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ection Area tab controls the following preferences.

tically create selection area after a mouse click 

lected, a selection area will be created around an area on 
u click with the cursor. 

tically set the Output Type after selection 

elected, the software automatically determines the output type 
ea inside the selection border.

tically adjust exposure after selection 

lected, the scanning software automatically changes the 
 in the Adjust Exposure and Adjust Black & White 
ld commands to the optimal values each time you create a 
ction area. Values for an image do not change if you create a 

 selection area while the Adjust Exposure or Adjust B&W 
ld dialog box is open.

leared, the scanning software does not automatically reset the 
 in these two tools.

tically adjust color after selection 

elected, the scanning software automatically changes the 
 in the Adjust Color command to the optimal values each time 
te a new selection area. Values never change if you create a 
 selection area while the Adjust Color dialog box is open.

leared, the scanning software does not automatically reset the 
.

%�����	���
	��
��	����

The Resolution tab controls th
when you select Resolution o

Default values are already set
values or delete values. Two r
dpi and 300 dpi, do appear in t
cannot be deleted because the
photos and black-and-white im

The range of resolution is 12 to
select a value and click Delete
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The Text tab of the Preferenc
preferences related to text out

Text Output (format) 

● Framed text. Places the te
attempts to recreate the pa
the original. Program into w
type of option.

● Flowed text. Eliminates co
any images in the text as c
the original.

Current OCR Language 

Allows you to choose the lang
words it is processing in the ite



62 Back to TOC

���	��
The C
range 

The co
availa
Black
the co
expos

Choos

● 8-b
res

● 10
res

● 12
res

● 16
res
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ontrols tab of the Preferences dialog box controls the control 
readout to use for scanning.

ntrol range sets the amount of tonal resolution per color 
ble for correction in the Adjust Exposure command and Adjust 
 & White Threshold command. Using a larger number of bits for 
ntrol range results in greater control of compensation for 
ure or threshold correction.

e one of these options:

it readout (0-255) — sets the controls to use 8 bits of tonal 
olution per color

-bit readout (0-1023) — sets the controls to use 10 bits of tonal 
olution per color

-bit readout (0-4095) — sets the controls to use 12 bits of tonal 
olution per color

-bit readout (0-65535) — sets the controls to use 16 bits of tonal 
olution per color
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You can
program
complia
New Ob
comman

When sc
Precisio
If the HP
the imag
TWAIN-

 
(

 other program by choosing the 
and. 

o software opens and displays the 
lection area. You can crop the scan (if 
ut type, and make optional adjustments 
 the appropriate sections in this chapter 

nges to the scanned image, do one of 
inal scan and place it in the program 
nning:

k Return image to 

n program. You might have to reposition 

he TWAIN-compliant program might not 
 type you selected. Rescan the image 
oftware sets for the image.
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 bring an image directly into an open file in one of your 
s if the program is TWAIN compliant. Generally, the program is 

nt if it has a command such as “Acquire,” “Scan,” or “Import 
ject.” If you are unsure if the program is compliant or what the 
d is called, see the documentation for the program.

anning from within a TWAIN-compliant program, the HP 
nScan Pro software may start if the TWAIN-program allows it. 
 PrecisionScan Pro software starts, you can make changes to 
e as you normally would. If not, the image returns to the 

program immediately.

If your program is not TWAIN compliant, you can try to 
copy and paste or drag-and-drop the image into the 
program. Or, save the image as a file and then place the 
file in the program.
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1 Start a scan from within the

Acquire (or similar) comm

2 If the HP PrecisionScan Pr
preview image, create a se
necessary), select the outp
as you normally would. See
for instructions.

3 When finished making cha
the following to perform a f
from which you started sca

● On the Scan menu, clic

● Click .

The image appears in the ope
the image. 

If the image does not appear, t
accept the resolution or output
using the default settings the s
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nner supports using the HP ScanJet Automatic Document 
(ADF) and the HP ScanJet Transparency Adapter (XPA) for 
egatives, and other transparent items. These accessories are 
 with some scanner models or can be ordered.
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You ca
When
softwa
see th
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1 Re

2 Pla
fac

ainst the left side of the input tray. Slide 
l the stack does not move any farther. 

anner

can menu in the HP PrecisionScan Pro 

 button except HP SCANNING 
ctions on the screen to complete the 

NING SOFTWARE scanner button or you 
e HP PrecisionScan Pro software: 

box opens and displays the current out-
d page size, which you can change. Or, 
tings and choose settings you have 

le, click Scan. Or, to scan directly to a 
 To, select a destination, and click Scan.
Using accessories

��
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�������",-

n scan multiple-page items quickly and easily using the ADF. 
 you use the ADF, you can scan to the HP PrecisionScan Pro 
re or other destinations. For instructions on setting up the ADF, 
e Setup and Support Guide.

�
���

	��
1'(
move any items from the scanner glass.

ce a stack of similarly sized originals in the document input tray, 
e up and with the first page on top.

3 Push the paper stack up ag
the stack into the ADF unti

4 Do one of the following:

● press a button on the sc

● click New Scan on the S
software

5 If you chose any scanner
SOFTWARE: Follow the dire
scan.
If you chose the HP SCAN

started scanning from th

 a The ADF Scan dialog 
put type, resolution, an
you can click Load Set
preset.

 b To scan the item to a fi
destination, click Scan
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You can
the XPA
transpar
scanner
normally
menu.

s, you need the larger template and the 

 its port on the scanner, restart the 

n the scanner glass so the wording 
 top, or closest to the hinged portion of 

“Hewlett Packard” 
here
to TOC
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 scan slides or negatives using the XPA. You should NOT use 
 to scan full-size (A4 or Letter) presentation slides and 
encies. To scan these full-size items, place them on the 
 glass, place a white piece of paper on top, and scan as you 
 would using the Scanner Glass command on the Scan 
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To scan standard 35 mm slide
smaller, slide template.

��
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1 With the XPA connected to

software.

2 Place the large template o
“Hewlett Packard” is at the
the lid. 
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3 Pla

4 Pla

5 If y
slo
qu

ge template. Align the XPA to fit in the 
late.

PA (Slides). 

s, see "Making optional adjustments for 
72.

PA, on the Scan menu, click Scanner 
 if you want.
Using accessories

ce the slide template in the cutout of the large template.

ce up to four slides, one in each slot, in the template.

ou are not using all of the slots in the template, cover the empty 
ts with the knock outs from the template to ensure best image 
ality.

6 Place the XPA over the lar
corner cutouts on the temp

7 On the Scan menu, click X

8 Before making any change
transparent items" on page

9 When finished using the X
Glass. Disconnect the XPA
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To scan
template
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1 With

softw

2 Plac
“Hew
the l

the light and verify which side of the 
xpected orientation of the picture.

 into the negative template so that the 
is facing outward, toward you.

wn into the large template.

re easily damaged. Touch them only by 

t using with the knock outs from the 
age quality.
to TOC
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 negatives, you need the larger template and the negative 
.


����	�#��
 the XPA connected to its port on the scanner, restart the 
are.

e the large template on the scanner glass so the wording 
lett Packard” is at the top, or closest to the hinged portion of 

id.

3 Hold your negatives up to 
negative strip shows the e

4 Slide the strip of negatives
correct view of the picture 

5 Place the template face do

CAUTION Negatives a
the edges.

6 Cover any slots you are no
template to ensure best im

“Hewlett Packard” 
here
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7 Pla
Th
clo

8 Pla
co

PA (Negatives).

e "Making optional adjustments for 
72.

PA, on the Scan menu, click Scanner 
 or set it aside.
Using accessories

ce the negatives template In the cut out of the large template. 
e graphic on the negatives template should be facing up and 
sest to the front (non-hinged) portion of the lid.

ce the XPA over the large template. Align the XPA to fit in the 
rner cutouts on the template.

9 On the Scan menu, click X

10 Before making changes, se
transparent items" on page

11 When finished using the X
Glass. Disconnect the XPA
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Transpa
them, yo
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1 With

softw

2 Plac
“Hew
the l

he cut out in the large template.

cies are easily damaged. Touch them 
edges.

 edges of the transparency.

ge template. Align the XPA to fit in the 
late.

�
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rencies are like 35 mm slides, only larger. When you scan 
u will use only the larger template.
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 the XPA connected to its port on the scanner, restart the 
are.

e the large template on the scanner glass so the wording 
lett Packard” is at the top, or closest to the hinged portion of 

id.

3 Place the transparency in t

CAUTION Transparen
only by the 

4 Cover any gaps around the

5 Place the XPA over the lar
corner cutouts on the temp

“Hewlett Packard” 
here
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6 On

7 Be
tra

8 W
Gl
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ents to transparent items scanned 
g to make adjustments, create a 

lide or negative so the software 
opping or selecting an area for final 

ents to the image after you create a 
hem as you normally would, except for 

idtones for transparent items" on 

ighlights for transparent items" on 

adows for transparent items" on 

r. See "Viewing RGB values and pixel 

 adjustments, basic" on page 37 and 
stments, advanced" on page 41 to 
 except the ones mentioned above.

negative, see "Resizing (output 
38.
Using accessories

 the Scan menu, click XPA (Slides).

fore making changes, see "Making optional adjustments for 
nsparent items" on page 72.

hen finished using the XPA, on the Scan menu, click Scanner 
ass. Disconnect the XPA or set it aside.
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You can make optional adjustm
using the XPA. Before decidin
selection area around one s
exposes it correctly. See "Cr
scan" on page 34.

If you choose to make adjustm
selection area, make most of t
the following adjustments:

● Midtone. See "Adjusting m
page 73.

● Highlight. See "Adjusting h
page 73.

● Shadow. See "Adjusting sh
page 74.

● RGB values and pixel colo
color" on page 74.

 
(
See "Making optional
"Making optional adju
make all adjustments

 
(
To enlarge a slide or 
dimensions)" on page



Back Using accessories 73

"�9���

You can
using th
field is -

��
����	�
1 On t

2 Do o

● D

● Ty

��
�����
1 On t
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2 Click
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hten or darken the light areas. The 
ghlights field is -100 to 100.

lick Adjust Exposure.

 to the right.

 the Highlights field and press ENTER.

lick Adjust Exposure.

 to the left.

the Highlights field and press ENTER.

�
lick Adjust Exposure.

dtone, highlight, and shadow settings to 
rent item.
to TOC
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 adjust the overall lightness or darkness of the scanned image 
e midtone setting. The range for the number in the Midtone 
100 to 100.

�
	���������	
�	�
�
�#�����
he Advanced menu, click Adjust Exposure.

ne of the following:

rag the Midtone slider to the right.

pe a higher number in the Midtone field and press ENTER.

�
	���������	
�	�
�
�#�����
he Advanced menu, click Adjust Exposure.

ne of the following:

rag the Midtone slider to the left.

pe a lower number in the Midtone field and press ENTER.

�
	�
	��
������	
��		����
he Advanced menu, click Adjust Exposure.

 Auto to return the midtone, highlight, and shadow settings to 
efaults for this transparent item.
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You can adjust highlights to lig
range for the number in the Hi

��
����	��
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�����
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Highlight slider

● Type a higher number in

��
������
����	��
�����
1 On the Advanced menu, c

2 Do one of the following:

● Drag the Highlight slider

● Type a lower number in 

��
��	���
	�
	��
������	
��		���
1 On the Advanced menu, c

2 Click Auto to return the mi
the defaults for this transpa
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and pixel color for any spot in an image, 
GB Meter.


�����
lick Adjust Exposure.

ges to an eyedropper.

rea in the item for which you want to see 
ear in the RGB area. A line appears in 
 where those pixels occur.

gain.
Using accessories

��
�������������
��
���(�
����
����

n adjust shadows to lighten or darken the dark areas. The range 
 number in the Shadows field is -100 to 100.

	��
������
�����
 the Advanced menu, click Adjust Exposure.

 one of the following:

Drag the Shadow slider to the right.

Type a higher number in the Shadows field and press ENTER.

���
������
�����
 the Advanced menu, click Adjust Exposure.

 one of the following:

Drag the Shadow slider to the left.

Type a lower number in the Shadows field and press ENTER.

��
	�
	��
������	
��		����
 the Advanced menu, click Adjust Exposure.

ick Auto to return the midtone, highlight, and shadow settings to 
 defaults for this transparent item.
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You can view the RGB values 
color or grayscale, using the R

��
#���
%)/
#�����
���
��!��
1 On the Advanced menu, c

2 Click . The cursor chan

3 Move the cursor over the a
the values. The values app
the histogram to show you

4 When finished, click  a
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canner sharing are automatically 
 when you install the HP PrecisionScan 
to be able to use the scanner, the host 
 sharing software, and sharing must be 
to TOC
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scanning software includes HP PrecisionScan LAN, a feature 
ws a user on one computer to use the scanning software with a 
 attached to another computer.

isionScan LAN requires at least two computers: one with the 
 connected to it (the host computer) and one or more not 
ed to the scanner (the remote computers). To be able to use 
ner, the computers must be on the same local area network 

s the scanner.
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The components that enable s
installed on the host computer
Pro software. For other users 
computer must be running the
enabled.
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to share the scanner, the host computer 
can LAN must be running, and scanner 
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 in the System Tray. If the icon is visible, 
unning. Otherwise, start the program.

en the HP PrecisionScan LAN Host 

e host computer and the network 
ill need this information to set up the 

rs must enter to use the scanner from 
 click the Password tab. Select the 
k box and then enter a password. 
Sharing the scanner on a network
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 Start menu, click Programs, point to HP ScanJet Utilities, 
ick Share Scanner.


�	�
�
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���	����
 host computer, a scanner icon appears in the system tray, 

d on the right side of the Windows Taskbar. Right-clicking this 
pens the right-click menu, which contains these items:

 the HP PrecisionScan LAN Host dialog box. This command 
ms the same action as double-clicking the icon.

atically Start 

 selected, HP PrecisionScan LAN starts automatically on the 
omputer each time the computer is started. If cleared, you must 
e program manually. 

own 

ing this menu item terminates HP PrecisionScan LAN and 
es its icon from the system tray. 

 HP PrecisionScan LAN Host

enu item gives you information about HP PrecisionScan LAN.
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In order for the host computer 
must be on, the HP PrecisionS
sharing must be enabled.
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	��
1 Check for the scanner icon

HP PrecisionScan LAN is r

2 Double-click the icon to op
dialog box. 

3 Click the Info tab. 

4 Write down the name of th
protocols supported. You w
remote computers.

5 To set a password that use
their computers (optional),
Require passwords chec

6 Click OK.
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ote computer, you must install 
t computer. Only install this software and 
ware. Installing any other software made 
included on the CD is a violation of 

tware CD into the CD-ROM drive.

ist of software components you can 
anning Installation.

the screen.
to TOC Sharing
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f computers on a local area network can use the HP ScanJet 
 connected to a host computer, as long as the following are 

remote computer has HP PrecisionScan LAN installed. See 
alling sharing software on the remote computer” on this page.

remote computer has sharing enabled. See “Enabling sharing 
e remote computer” on this page.

host computer has enabled scanner sharing. See "Enabling 
ing from the host" on page 76.

u have performed the setup procedures, you can use the 
. See "Scanning from a remote computer" on page 78.
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To use the scanner from a rem
HP PrecisionScan LAN on tha
the HP PrecisionScan Pro soft
by another company that was 
copyright agreements.

��
���	���
	��
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���	����
1 Insert the HP scanning sof

2 Choose Install Software.

3 When presented with the l
install, choose Remote Sc

4 Follow the instructions on 
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 a remote computer. Only one user at a 
, the HP ScanJet Copy Utility is not 

�	��
 down on the scanner glass and close 

tart the HP PrecisionScan Pro software.

word. The person whose computer is 
ets the password.

 help with scanning procedures, see 
onScan Pro" on page 31.
Sharing the scanner on a network
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stalling the software on the remote computer, enable sharing on 
mputer.
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�������
��
�
��
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��
��	��
 the Start menu, point to Programs, point to HP ScanJet 
ilities, and click Remote Scanning Setup.

the Remote Setup dialog box, select the Use Remote Scanner 
eck box.

ecify the name of the computer where the scanner is installed 
st computer).

ter the password (if used) for the host computer.

sure that a matching network protocol is selected. This 
ormation is found in the HP PrecisionScan LAN dialog box on 
 host computer.

ick OK.

peat steps 1 through 6 to enable sharing on other remote 
mputers.
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Using the scanner is easy from
time can use the scanner. Also
available.
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	��
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1 Place the original item face

the lid.

2 On the remote computer, s

3 If prompted, enter the pass
connected to the scanner s

4 Start scanning. If you need
"Scanning from HP Precisi
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lways perform these actions first.

 is securely connected between the 
l outlet or surge protector.

cted to a surge protector, make sure the 
into an outlet and turned on.

SI cable is securely connected between 
ter.

nlocked. Move the lock down to the 

e from the scanner and turn off the 
s, reconnect the power cable to the 
he computer, in that order.

ose it. Press CTRL+ALT+DELETE to open 
anager. Select any program listed as 
End Task.

he issue, see "Starting troubleshooting" 
to TOC
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tion provides information for:

ing issues that might occur while using the scanner or 
canning software, or issues with the appearance of scanned 
es. Start with “Checking the basics” on this page. 

ring jams from the ADF. See "Clearing jams from the ADF" on 
97.

ning and maintaining the scanner and accessories. See 
aning and maintaining" on page 99.

es that occur during installation or the first time you scan, see 
p and Support Guide.
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If the scanner is not working, a

● Check that the power cable
scanner and a live electrica

● If the power cable is conne
surge protector is plugged 

● Check that the USB or SC
the scanner and the compu

● Make sure the scanner is u
unlocked position.

● Disconnect the power cabl
computer. After 30 second
scanner and then turn on t

● If a program has frozen, cl
Close Programs or Task M
Not Responding and click 

If these steps did not resolve t
on page 80.
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ding to destinations" on page 91.
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e ADF. See "Clearing jams from the 

e ADF, other than pages jamming. See 
he ADF" on page 96.

e XPA. See "Resolving issues with the 
Troubleshooting usage and maintaining
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ere to find the information you need. Choose one of these 
l groups of issues, and then choose one of that group’s more 

ic issues.
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A message is on the scanner or the computer. Follow the 
directions in the message to resolve the issue.

There is no message. See "Resolving issues that did not 
generate messages" on page 81.
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Scanned images do not look good. See "Resolving issues with 
scanned images" on page 84.

Printed copies do not look good. See "Resolving issues with 
printed copies" on page 86.

Text on images is not editable. See "Resolving issues with 
editable text" on page 89.

Slides or negatives do not look good. See "Resolving issues 
with slides and negatives" on page 88.
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See "Resolving issues sen
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	��
● Pages are jammed in th

ADF" on page 97.

● There is an issue with th
"Resolving issues with t

● There is an issue with th
XPA" on page 95.
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save
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You 
use.
the F
file t

s might be causing the problem:

talled properly.

s were not installed properly.

is not compatible with the scanner.

not properly set, or multiple SCSI 
me address.

 a grinding sound, the scanner is 

 on page 79 and the Setup and Support 

������$>
 used for a while, the scanner lamp has 

few seconds for scanning to begin.
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Check that the USB or SCSI cable is 

 set to open when you press E-MAIL, 
 scanner. See "Changing settings for 
to TOC Troubleshooti

1
���
������������
����������
����
����

anner or software is not working but no message appears, look 
ause and solution in this section.
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>
scanned image might not have been saved as a file. If you 
 an image directly to a destination, the scanned image is not 
d on the computer. Use the FILE button on the scanner, or 
 files using the HP PrecisionScan Pro software.

���
�!��(����$����>
scanner lamp stays on as long as the software is running and 
t stay on for a while after the software is closed. This is 
al, and the lamp will turn off on its own.
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might have saved the file in a format the other program cannot 
 Save the file in a different format the program can use. Look in 
ile Open or Import command for the program to see which 

ypes it supports.
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One or more of these issue

● The scanner was not ins

● The SCSI card or driver

● The SCSI card or cable 

● The scanner address is 
devices are set to the sa

● If the scanner is emitting
locked.

See "Checking the basics"
Guide.
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�
If the scanner has not been
turned itself off. Wait for a 
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● A cable might be loose. 
securely connected.

● Check which program is
FAX, or EDIT TEXT on the
buttons" on page 24.
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e sure that HP PrecisionScan Pro is 
t This Program.

o action check box is cleared.

 Windows 95: 

oint to Programs, point to HP ScanJet 
P ScanJet Button Manager. 

vents list, select HP Scannning 

ecisionScan Pro check box is selected.

le Events check box is cleared.
Troubleshooting usage and maintaining
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A cable might be loose. Check that the USB or SCSI cable is 
securely connect ed.

You might have accidentally turned off the preview feature. 
Check this setting on the Scanner tab in the Preferences of the 
HP PrecisionScan Pro software. See "Setting preferences" on 
page 60.

Check that the HP PrecisionScan Pro software is the program 
set to start when you press HP SCANNING SOFTWARE.

In Windows 98 and 2000: 

1 On the Start menu, point to Settings, and click Control 
Panel. 

2 Double-click Scanners and Cameras. 

3 Select your scanner model number from the list, if it is not 
already selected. 

4 Click Properties. 

5 From the Scanner Events list, select HP Scannning 
Software button.

6 Make sure the HP PrecisionScan Pro check box is selected.

7 Make sure the Disable Device Events check box is cleared.

n Windows Me: 

1 On the Start menu, point to Settings, and click Control 
Panel. 

2 Double-click Scanners and Cameras. 

3 Double-click the icon next to the name of your scanning 
device.

4 From the Select an Event list, choose the HP Scanning 
Software button.

5 Under Actions, mak
selected next to Star

6 Verify that the Take n

In Windows NT 4.0 and

1 On the Start menu, p
Utilities, and click H

2 Click the Events tab.

3 From the Scanner E
Software button.

4 Make sure the HP Pr

5 Make sure the Disab
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ion for resolving image-quality issues, 
e scanner glass, the ADF, or the XPA.

ned images. See this page.

ed copies. See page 86.

s and negatives. See  page 88.

est output type possible, use the 
 are not showing, click .
to TOC Troubleshooti
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you are scanning to edit text, the OCR program causes the 
anner to scan more slowly, which is normal. Wait for the item 
 scan.

ome default settings can cause the scanner to scan more 
owly. Check the settings. See "Setting preferences" on 
ge 60.

he resolution might be set too high. Return to the default 
solution. See "Changing resolution" on page 38.
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>
you used the ADF and then disconnected it, restart the 
ftware.

you were using the XPA, on the Scan menu, click Scanner 
lass to scan from the glass again. 

you are trying to use the XPA and the XPA (Slides) or XPA 
egatives) commands are unavailable, restart the software 

hile the XPA is connected to the scanner.
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��>
scanner is locked. Unlock the scanner. Use your finger to flip 
ock down to the unlocked position. 
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This section contains informat
whether you scanned using th

● Resolving issues with scan

● Resolving issues with print

● Resolving issues with slide

 
(
For help getting the b
Guided Steps. If they
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t be dirty. Clean the glass. See 
on page 99.

, there might be a page on the scanner 
it and remove any pages on the scanner 

, the ADF window might be dirty or 
F window. See "Cleaning the ADF" on 
es not correct the issue, the ADF 
e replaced. See "Replacing the 
02.

ing, or midtone, highlight, and shadow 
e adjusted before scanning. See 
isionScan Pro" on page 31.

 colored paper. If the original was 
er, including brown recycled paper, the 
e clear. Try adjusting the resolution and 
hadow settings from the 
oftware. See "Scanning from HP 
age 31.
Troubleshooting usage and maintaining
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ection contains solutions to issues that affect all scanned 
s, regardless of whether you used the scanner glass or the ADF. 
were printing, see also "Resolving issues with printed copies" on 
6.
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e original image might be very light or dark or be printed on 
lored paper. Adjust the midtone, highlight, and shadow settings 
m the HP PrecisionScan Pro software. See "Scanning from HP 
ecisionScan Pro" on page 31.

���
��������1���!����������
���
�����
����(������������
��>�

ere might be ink, glue, white-out, or some other substance on 
 scanner glass. Clean the scanner glass. See "Cleaning the 

anner" on page 99.
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● The scanner glass migh
"Cleaning the scanner" 

● If you are using the ADF
glass. Raise the ADF un
glass.

● If you are using the ADF
scratched. Clean the AD
page 100. If cleaning do
window might need to b
ADF Window" on page 1
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>

● The resolution, sharpen
settings might need to b
"Scanning from HP Prec

● The original might be on
printed on a colored pap
image or text might not b
midtone, highlight, and s
HP PrecisionScan Pro s
PrecisionScan Pro" on p
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s to be increased. In the 
ware, adjust the sharpening. See 
 page 40.

�����:��
���77$>
 a program other than the 
oftware. Resize the image in the 
oftware before you send it to the other 
 (output dimensions)" on page 38.) Or, if 
and-white drawing, use the Black & 
pe for the scanned image. (See 
n page 36.)

 Pro software, the resolution is set too 
 a higher number, or return to the 

anging resolution" on page 38.

 Pro software, too much or too little 
. Adjust the sharpening. See 
on page 40.
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e manually. Return to the default 

g an image" on page 40.

 is selected. Check the setting. See 
 page 60.
to TOC Troubleshooti
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��>
he item might not be placed correctly on the scanner glass or in 
e ADF. Make sure that the item you are trying to scan is placed 
ce down on the glass, or face up in the ADF.

you are using the ADF, there might be a page on the scanner 
ass. Raise the ADF unit and remove any pages on the scanner 
ass.

you are using the ADF, the ADF window might need to be 
placed. See "Replacing the ADF Window" on page 102.
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ners, monitors, printers, and different operating systems 

pret color differently. Use the hue and saturation settings in the 
recisionScan Pro software to adjust the colors.
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selection area might not be selected correctly. Make sure the 
ction border is surrounding the area you want in the final scan.
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item might have been placed crookedly or shifted when you 
ed the lid. Straighten the original on the scanner glass and 
 again.
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might have zoomed in or out, which does not change the size 
e image. Change the output size. See "Resizing (output 
nsions)" on page 38.
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The sharpening level need
HP PrecisionScan Pro soft
"Sharpening an image" on
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● You resized the image in

HP PrecisionScan Pro s
HP PrecisionScan Pro s
program. (See "Resizing
the original was a black-
White Scalable output ty
"Selecting output type" o

● In the HP PrecisionScan
low. Set the resolution to
default setting. See "Ch

● In the HP PrecisionScan
sharpening was applied
"Sharpening an image" 
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● You sharpened the imag
setting. See "Sharpenin

● Best Quality Sharpening
"Setting preferences" on



86 Back to TOC

%�������
������

●

●

%����
������
������

Th
the
pro
siz

 ���
�
In 
he
dim

)���
������

Sc
Gu
be


�������(
��

e issues with printed pages.
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p to the edge of the paper. To get the 
able area, you must slightly reduce the 
 PrecisionScan Pro software and then 

m printed on colored paper, there might 
etween the ink and paper colors. Adjust 
 midtones, and resolution settings from 
ro software. See "Scanning from HP 
age 31. Or, adjust the contrast from the 
. Also, if possible for text, use originals 
 white paper.

 of toner or ink. Print a different file from 
printer to see if the issue lies with the 
Troubleshooting usage and maintaining
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Setting the resolution to a higher number does not necessarily 
improve quality. The software sets the resolution automatically 
based on the type of item you scanned. Keep or return to the 
default. See "Changing resolution" on page 38 or "Tips for best 
image quality" on page 59 for guidelines.

If you sent the image to another program, the program might not 
support the resolution you set in the HP PrecisionScan Pro 
software. Determine the setting the program uses and set the 
resolution in the HP PrecisionScan Pro software to that 
resolution.
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e other program did not accept the image size information. Scan 
 image at a lower resolution. When you scan at a resolution the 
gram accepts, it will display or print the image at the correct 
e.
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the HP PrecisionScan Pro software, set the physical width and 
ight of the image in the Resize dialog box. See "Resizing (output 
ensions)" on page 38.
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an settings for this image might be set incorrectly. Use the 
ided Steps for help choosing an output type. See also "Tips for 
st image quality" on page 59.
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● If you are copying an ite
not be enough contrast b
the highlights, shadows,
the HP PrecisionScan P
PrecisionScan Pro" on p
HP ScanJet Copy Utility
printed with black ink on

● The printer might be out
another program to the 
printer.
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int again. Check the printer settings. If it 

he printer is out of ink or toner. 
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P PrecisionScan Pro software might not 
 output type to True Color (16.7 million 
e "Selecting output type" on page 36.

in a file in another program, resized the 
from that program, resizing the image in 
used the issue. Resize the image in the 
oftware before placing it in a file in 
esizing (output dimensions)" on 

 fuzzy and you enlarged it, the fuzziness 
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he printer might be out of toner or ink. Print a different file from 
other program to the printer to see if the issue lies with the 
inter.

he scanner internal mirror might be contaminated. Contact the 
ustomer Service Center for service.
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page might be too complex. (The printer does not have 
gh memory to process the page.) Set the resolution of the 
e to 300 dpi or less in the HP PrecisionScan Pro software. 

 "Changing resolution" on page 38.
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● The output type in the H

be set correctly. Set the
colors) or Grayscale. Se

● If you placed the image 
image, and are printing 
the program probably ca
HP PrecisionScan Pro s
another program. See "R
page 38.

● If the original image was
becomes more obvious.
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ed incorrectly on the scanner bed. Turn 
g “Hewlett Packard” is at the top, or 
n of the lid.
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laced incorrectly on the scanner bed. 
 wording “Hewlett Packard” is at the top, 
portion of the lid. 

sure command in the Advanced menu.
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or negative for damage.

he top of the large template might be 
 If there are scratches or blemishes, turn 
can again to see if the streak moves to 
n. If the streaks move, then the template 
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 XPA might be broken or not working. 
 the scanner, hold the XPA up and look 
th sides of the XPA. If a bulb is broken, 
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e following section to help resolve issues with slides, negatives, 
her transparent media scanned using the XPA. All actions must 
formed in the HP PrecisionScan Pro software, because you 
can slides, negatives, and other transparent items using this 
re. See also "Resolving issues with the XPA" on page 95.
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u might have used the Zoom In command, which only changes 
 view on the screen. Use the Resize command to change the 
e of the final scanned image. See "Resizing (output 
ensions)" on page 38.
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The software might be setting exposure for the entire area 
instead of one slide or negative. Create a selection area around 
the slide or negative you want to use to ensure it is exposed 
correctly. 

The template is not placed completely on the scanner glass. 
Make sure the template is completely on the scanner glass.
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e slide was probably scanned without using the slide template, 
the template was placed incorrectly. Use the included slide 
plate to scan slides. Turn the template so the wording “Hewlett 

ckard” is at the top, or closest to the hinged portion of the lid. 
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● The template might be p
Turn the template so the
or closest to the hinged 

● Check the Adjust Expo
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● Check the original slide 

● The calibration area at t
scratched or blemished.
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the other side of the sca
needs to be replaced.
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for even illumination on bo
service is required.



Back ng usage and maintaining 89

;���!

This sec
are tryin

�������
● If 

on

● If 
m
ch
Ty
ch
w

�������
Som
Mak

 ������
60�;8��

The 
is no

�������&��������������1�
������
�������

program depends on the quality of the 
ct setting. To obtain the best possible 
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 on the scanner, text opens in Word or 
ange which program displays the text. 
 for buttons" on page 24.

 PrecisionScan Pro software, choose 
 Text and Image on the Output Type 
n menu, click Scan To and choose the 
ut and paste the text into the program 
till not editable, work with the text as an 

���&����
������
���
����0�;�(
��
��>

 PrecisionScan Pro software, save the 
age file, and open the file in the other 

nScan Pro software. Then, on the Scan 
d choose the other OCR program. 
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g to make text editable.
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you pressed a button on the scanner, you might have chosen 
e other than EDIT TEXT. Choose EDIT TEXT.

you used the HP PrecisionScan Pro software, the software 
ight have identified the text as a drawing. In the software, 
oose Editable Text (OCR) or Text and Image on the Output 
pe menu. Then, on the Scan menu, click Scan To and 
oose the program you want. If the text is still not editable, work 

ith the text as an image or retype it.
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e programs accept only image formats and do not allow text. 
e sure the program accepts editable text.
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OCR program causes the scanner to scan more slowly, which 
rmal. Wait for the item to scan.
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The accuracy of the OCR 
original item and the corre
results, choose the scan se
clear text. See "What to ex
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Do one of the following.

● If you pressed EDIT TEXT

WordPad by default. Ch
See "Changing settings

● If you scanned to the HP
Editable Text (OCR) or
menu. Then, on the Sca
program you want. Or, c
you want. If the text is s
image or retype it.
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Do one:

● Scan the item to the HP
scanned image as an im
OCR program.

● Scan to the HP Precisio
menu, click Scan To an
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rd-processing programs cannot always accept the original 

matting of the scanned text. Reformat the text in the word-
cessing program.
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You can try to keep formatting (framed) or not (flowed). Change 
the preference to the one you want. For the EDIT TEXT button on 
the scanner, see "Changing settings for buttons" on page 24. 
For the HP PrecisionScan Pro software, see "Setting 
preferences" on page 60.

Even if you want to retain the formatting and you have the 
setting set correctly, the receiving word-processing program 
cannot always accept the formatting. Reformat text in the word-
processing program.
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Check that the USB or SCSI cable is 

 set to open when you press E-MAIL, 
 scanner. See "Changing settings for 
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ecisionScan Pro software and print from 
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DF, each page is treated as a separate 
 copies of one page, but not multiple 
nd collate them.
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, Text and Image, or Black and White 
lected, the Print command is 
rent output type and then print.
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 section to resolve issues sending images to destinations.
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e-mail program is Web-based or might not be supported. Save 
canned image as a file and attach it to your e-mail message 

ou normally do.
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ake text editable for a recipient, scan the item to the 
recisionScan Pro software and change the output type for the 
ned image to Editable Text (OCR). Then, on the Scan menu, 
 Scan To and select the e-mail program. Or, save the scanned 
e as a file and attach it to a message as you normally do.
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PC fax program might not be supported. Save the scanned 
e as a file and attach it to your fax message as you normally 
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● A cable might be loose. 
securely connected.

● Check which program is
FAX, or EDIT TEXT on the
buttons" on page 24.
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If the Editable Text (OCR)
Scalable output type is se
unavailable. Choose a diffe
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e sure that HP PrecisionScan Pro is 
t This Program.

o action check box is cleared.

 Windows 95: 

oint to Programs, point to HP ScanJet 
P ScanJet Button Manager. 

vents list, select HP Scannning 

ecisionScan Pro check box is selected.

le Events check box is cleared.
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A cable might be loose. Check that the USB or SCSI cable is 
securely connected.

You might have accidentally turned off the preview feature. 
Check this setting on the Scanner tab in the Preferences of the 
HP PrecisionScan Pro software. See "Setting preferences" on 
page 60.

Check that the HP PrecisionScan Pro software is the program 
set to start when you press HP SCANNING SOFTWARE.

In Windows 98 and 2000: 

1 On the Start menu, point to Settings, and click Control 
Panel. 

2 Double-click Scanners and Cameras. 

3 Select your scanner model number from the list, if it is not 
already selected. 

4 Click Properties. 

5 From the Scanner Events list, select HP Scannning 
Software button.

6 Make sure the HP PrecisionScan Pro check box is selected.

7 Make sure the Disable Device Events check box is cleared.

n Windows Me: 

1 On the Start menu, point to Settings, and click Control 
Panel. 

2 Double-click Scanners and Cameras. 

3 Double-click the icon next to the name of your scanning 
device.

4 From the Select an Event list, choose the HP Scanning 
Software button.

5 Under Actions, mak
selected next to Star

6 Verify that the Take n

In Windows NT 4.0 and

1 On the Start menu, p
Utilities, and click H

2 Click the Events tab.

3 From the Scanner E
Software button.

4 Make sure the HP Pr

5 Make sure the Disab
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 software might not recognize the 
Do one of the following:

e in a file type the other program uses, 
 the other program.

-and-drop the image into the other 

at is not being recognized. This might 
can Pro software to recognize it.
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e TWAIN compliant. If you cannot find a 
e, check the documentation for the 
liant. If not, do one of the following in the 
ware:

 as a file and then insert the file into the 

Scan menu, and choose a program.

-and-drop the image into the other 
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y default, text opens in Word or WordPad. Change which 
ogram displays the text. See "Changing settings for buttons" 
 page 24.
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use the File option is for archiving files, the .pdf format is used 
ep formatting and provide a small file size. To save in a 

rent file format, scan the item to the HP PrecisionScan Pro 
are and use the Save As command on the Scan menu.
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e programs only allow scanned images to be placed into new 

. Cut and paste the image into the file you want. Or, save the 
ned image as a file and import it into the other program.

)����%��
$������������������
�������������������������
��
���������������((��
>�

The HP PrecisionScan Pro
program as a destination. 

● Save the scanned imag
and then open the file in

● Copy and paste or drag
program.

● Reinstall the program th
allow the HP PrecisionS
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The other program must b
command such as Acquir
program to see if it is comp
HP PrecisionScan Pro soft

● Save the scanned image
other program. 

● Click Scan To from the 

● Copy and paste or drag
program.
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WAIN-compliant program might not accept the resolution or 
 type you selected. Rescan the image using the default settings 
 PrecisionScan Pro software sets for the image.



Back ng usage and maintaining 95

;���!

This sec
using th

;���!1

This sec
transpar
and neg

 ���.�"
The 
XPA

)�����
6=����


● T
X

● If 
so
so

�!
����
�������
���(�
���$����(��
�����
�
�6=����
1��8�
���������������>
ected XPA (Slides) or XPA (Negatives) 
he HP PrecisionScan Pro software. If 
e unavailable, restart the software while 
 the scanner.

 in the XPA might be broken or not 
onnected to the scanner, hold the XPA 
mination on both sides of the XPA. If a 
s required.
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tion contains information for resolving issues when you are 
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tion contains issues that might occur when you are using the 
ency adapter (XPA). See also "Resolving issues with slides 
atives" on page 88.
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XPA cable might not be connected correctly. Make sure the 
 cable is connected securely to the XPA port on the scanner.
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he XPA cable might not be connected correctly. Make sure the 
PA cable is connected securely to the XPA port on the scanner.

you connected the XPA while the HP PrecisionScan Pro 
ftware was running, restart the software. Doing so allows the 
ftware to detect the XPA.
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● Make sure you have sel
from the Scan menu in t
these two commands ar
the XPA is connected to

● One or both of the bulbs
working. With the XPA c
up and look for even illu
bulb is broken, service i
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 the guidelines for the ADF. See "Items 

ething on it. Make sure you have 
as staples and self-adhesive notes on 
 and preparing items" on page 7.

e ADF can handle items as small as 
y 8.3 inches). Use the glass to scan.

e ADF can handle items as large as 216 
 inches). Use the glass to scan the item 
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ms up to 355.6 mm (14 inches) long. If 
it in sections on the glass. If the item is 
se the correct page size setting in the 
before scanning.

em might be too complex (require too 
rinter to process. If possible, choose a 
ry. Or, select a lower resolution or 
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the scanner glass. Raise the ADF unit 
the scanner glass.
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ection contains issues that might occur when you are using the 
atic document feeder (ADF).
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If the pages look like they are skewing as they feed into the ADF, 
check the resulting scanned images in the software to ensure 
they are not skewed.

The item might not be placed correctly. Straighten the item and 
make sure the left edge of it is placed against the left side of the 
input tray.

The maximum number of pages the ADF input and output trays 
can hold is 50, depending on the type of media being loaded. 
Make sure to load only 50 or fewer pages in the input tray, and 
remove pages from the output tray if they are stacking up to a 
pile of more than 50.

The item loaded might not meet the specifications for the ADF. 
Make sure the type of media being loaded meets required 
specifications. See "Items for the ADF" on page 7.
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e document input tray might not be securely latched. Raise the 
tch and the input tray, and then lower them, pressing firmly. See 
 clear jams at the end of a page" on page 98 for illustrations.
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● The item does not meet

for the ADF" on page 7.

● The item might have som
removed anything such 
the item. See "Selecting

● The item is too small. Th
148.5 by 210 mm (5.9 b

● The item is too large. Th
by 355.6 mm (8.5 by 14
in sections.
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● The ADF can handle ite

the item is longer, scan 
the correct length, choo
ADF dialog box prompt 

● If sent to a printer, the it
much memory) for the p
printer with more memo
different output type.
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There might be a page on 
and remove any pages on 
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 computer, reselect any settings you had 
 or Scan again.
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e holding down on the document input tray, raise the hatch.

ove the jammed paper.

3 Remove the item from the 

4 Close the hatch. Press dow
click.

5 Restack all pages and relo

6 On the ADF prompt on the
changed and click Scan To
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ad them into the ADF. 

computer, reselect any settings you had 
 or Scan again.
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hile holding down on the document input tray, open the hatch.

move any pages from the input tray.

hile holding the document output tray down, open the document 
ut tray.

4 Remove the jammed pape

5 Close the input tray and the
both sides until you hear a

6 Restack all pages and relo

7 On the ADF prompt on the 
changed and click Scan To
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ft, lint-free cloth sprayed with a mild 

ass cleaner. Avoid abrasives, acetone, 
d carbon tetrachloride, all of which can 
 scanner glass. Avoid isopropyl alcohol 
an leave streaks on the glass.

 a dry, soft, lint-free cloth.

the power cable to the scanner.

 underside of the glass do not affect the 
s because this area of the glass is 
canner. 
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maintenance, especially if you are seeing marks or smudges 
ned images. 
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ht need to clean the scanner glass if the ink on items you are 
g can be smudged with your hand or items have excessive 
 of dust or dirt on them. You might also need to clean these 

here are smudges or other marks on scanned images.

��
�����
	��
�������
1 Disconnect the power cabl

2 Open the scanner lid.

3 Clean the glass using a so
glass cleaner.

CAUTION Only use gl
benzene, an
damage the
because it c

4 Dry the scanner glass with

5 When finished, reconnect 

Fingerprints or smudges on the
appearance of scanned image
outside the focal point of the s
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�!��

Clean
windo

�!��

You m
scann

● AD

● gra

● rol

● se

e from the scanner.

 document input tray, open the hatch.

ation pad with a soft, clean, lint-free 
e cloth with isopropyl alcohol.
Troubleshooting usage and maintaining

�
�������.�"�

 the XPA with a dry, soft cloth. If necessary, spray the cloth with 
w cleaner or isopropyl alcohol.

�
�������",-

ust clean these parts of the ADF to maintain high-quality 
ing:

F window

y bar above the ADF window

lers

paration pad

��
�����
	��
1'(
1 Disconnect the power cabl

1 While holding down on the

2 Wipe the rollers and separ
cloth. You might dampen th

Separation pad

Rollers
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3 Whil
inpu

4 Wipe
the c

CA

ve the ADF window. The bar should be 
 markings. If necessary, clean the flat 

n close the hatch. Press down firmly on 
 click.

ass is also clean. See "Cleaning the 
to TOC Troubleshootin

e holding the document output tray down, open the document 
t tray.

 the ADF window, which is a long, clear bar. You may dampen 
loth with window cleaner, water, or isopropyl alcohol.

UTION Use only these cleaning fluids, and spray them only 
on a cloth. Using other cleaning fluids or spraying any 
fluids on the ADF can damage the ADF window.

5 Check the flat gray bar abo
gray without black or other
gray bar.

6 Close the input tray and the
both sides until you hear a

7 Ensure that the scanner gl
scanner" on page 99.

ADF window
ADF window

Flat, gray bar
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If the A
to repl

��
��

1 Di

2 Lif
se

F to expose the ADF window.

ach of the four Z-shaped hooks until the 
ush the long, pointed tab on the end of 
Troubleshooting usage and maintaining

�
�������",- )
����

DF window becomes scratched or uncleanable, you might need 
ace it. Order the ADF window from Hewlett-Packard.

�#�
	��
1'(
������
sconnect the ADF cable from its port on the scanner.

t the ADF off of the scanner. Lift firmly using your fingers to 
parate the rear bracket from the scanner.

3 Lift the input tray of the AD

4 Using a small coin, push e
tab snaps out of position. P
the window.
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��
���	�
1 Posi

hole

2 Rota
the A

3 Che

4 Beg
push

5 Verif

6 Rec
to TOC Troubleshootin

��
	��
���
1'(
������
tion the four Z-shaped hooks of the ADF window into the four 
s on the bottom of the ADF.

te the ADF window back until it contacts the bottom of 
DF.

ck that the long, pointed tab is on the inside of the ADF.

inning the with Z-shaped hook closest to the long, pointed tab, 
 each of the Z-shaped hooks toward the back of the ADF.

y that the long, pointed tab is on the inside of the ADF.

onnect the ADF cable to its port on the scanner.
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The U
scann

��
���

N

1 Cl

2 Do

3 Se

4 Fo

((�
�:�����

 contains information about these topics:

bleshooting. Find setup instructions and 
 for issues that can arise when you 

ites and other tools that contain 
ers, and the latest information about 

t information for your region if you need 

s. See this topic for the warranty and 
rmation.

 is located on the CD in the folder for 
puter in the PrecisionScan Pro folder. If 
tall in the default location, the path is: 
ard\PrecisionScan Pro 3.0.
Troubleshooting usage and maintaining

���!!
�������������
�

ninstall option of the setup program allows you to remove the 
ing software from your computer.

��	���
	��
���	����


ote: To uninstall the software from Windows NT 4.0 and 
2000, you must log on with administrator privileges.

ick Start, point to Settings, and click Control Panel.

uble-click the Add/Remove Programs icon.

lect the HP PrecisionScan Pro software and click Add/Remove.

llow the instructions on screen.

0���
�
����
���:���
�(��
�
���
���

The Setup and Support Guide

● Setup instructions and trou
troubleshooting information
install the scanner.

● Resources. Discover webs
scanning tips, updated driv
your HP scanner.

● Support. Locate the contac
to contact HP.

● Warranty and Specification
product and regulatory info

The Setup and Support Guide
your language, or on your com
you allowed the software to ins
C:\Program Files\Hewlett-Pack
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� ����	

This sec
cursors 

The HP 
to give y
Info bar 
context-
scannin
to TOC
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���

tion contains information for using the shortcuts, toolbars, and 
in the HP PrecisionScan Pro software. 

PrecisionScan Pro contains keyboard shortcuts and toolbars 
ou quick access to software commands. The Status bar and 
provide information about the scanned image. And, the 
sensitive cursors type of activity you can perform in the 
g software.
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��
�

This s
HP Pr
keybo
menu.
underl

This s
keybo

New

Sca

Ret

Sav

Prin

Prin

Sca
XPA
XPA

Set

S

L

Pre

Exi

Scan

+Z Return all settings except output type to 
the defaults for this image.

+C Scan and place the selection area on 
the Clipboard.

+A Select the entire scanner glass 
(including blank space).

Remove the selection border.

Zoom in on the selection area.

Zoom out to the original view.

Show or hide the Guided Steps.

Show or hide the toolbar.

Show or hide the Info bar.

Show or hide the Status bar.
����$���
�����
�������������������

ection summarizes the menus and commands in the 
ecisionScan Pro software that you can select using the 
ard. To open a menu, press ALT+ the underlined letter for that 
 To perform a command, open the menu and press the 
ined letter for that command.

ection also shows which commands can be performed using a 
ard accelerator (shortcut). 

 Scan CTRL+N Start (preview) a new scan.

n To... CTRL+T Scan and send to a destination, such as e-
mail

urn to When using TWAIN or WIA, return the 
scanned image to the other program.

e As... CTRL+S Save the selection area as a file.

t CTRL+P Scan and print the selection area.

t Setup Change printing options.

nner Glass
 (Slides)
 (Negatives)

Select the source from which to scan. Only 
one can be selected. 

tings

ave Save settings.

oad Load (use) settings.

ferences Change scanning default preferences.

t ALT+F4 Close the HP PrecisionScan Pro software.

Undo Editing Changes CTRL

Copy CTRL

Select All CTRL

Unselect All ESC

Zoom In 

Zoom Out

Guided Steps

Tool Bar

Info Bar

Status Bar

Edit

View
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True C
colors

256-C
palette

256-C

Spot C

Grays

Black 

Black 

Editab

Text a

Autom

Rotate

Rotate

Mirror

Resize

Chang

Sharp

Output 

Tools

Adjust colors (hue) and their intensity 
(saturation).

Adjust the contrast (midtones), detail in 
light areas (highlights) and detail in dark 
areas (shadows).

Adjust which values in the image will be 
represented as black or white.

Make colors in the image their 
opposites.

In the scanned image, reduce the 
appearance of undesirable patterns 
that are in a printed original.
to TOC

olor (16.7 million 
)

Choose the Output Type. Only one can 
be selected. For help choosing an 
Output Type, show the Guided Steps 
from the View menu.

olor (optimized 
)

olor (web palette)

olor (16-color)

cale 

& White Bitmap

& White Scalable

le Text (OCR)

nd Image

atically Set Type Allow the software to select the output 
type based on the contents of selection 
area.

 Left 90° Rotate the image counterclockwise by 
90 degrees.

 Right 90° Rotate the image clockwise by 90 
degrees.

Reverse the image side-to-side.

 Resize the selection area. This 
changes the output file size also.

e Resolution Change the resolution of the final 
scanned image.

en Adjust the sharpening.

Type

Adjust Color

Adjust Exposure

Adjust Black & White 
Threshold

Invert Colors

Descreen

Advanced
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Con

Sea

Wha

HP 

Pro

Use

Ena

Disa

Abo
Pro

Help
tents F1 View Help topics (contents).

rch Look for a Help topic.

t’s This? SHIFT+F1 Display context-sensitive Help for the 
selected software tool or feature.

ScanJet on the Web Connect to the Internet and visit the 
HP ScanJet website.

duct Tour View the product tour.

r’s Manual View the printable user’s manual in .pdf 
format.

ble All Smart Friends Allow helpful alerts to appear when 
potential problems arise.

ble All Smart Friends Prevent helpful alerts from appearing 
when potential problems arise.

ut HP PrecisionScan View information about the program, 
version, and copyright.
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����

��
�

The HP 
and an I
about th

 ��!��

The HP 
shortcut

��


r sharpening easier, you can add the 
Reset Sharpen tool to the toolbar. 

hange Resolution or Sharpen. 

s, place the cursor over the title of the 
old down the mouse button. 

n on the toolbar and release the mouse 

Click thi

tate the image counterclockwise by 90 degrees.

tate the image clockwise by 90 degrees.

turn all settings except output type to the 
aults for this image.

ow or hide the Guided Steps.

play context-sensitive Help for the selected 
tware tool or feature.
to TOC
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PrecisionScan Pro software contains a toolbar, a Status bar, 
nfo bar to help you use commands quickly or find information 
e current scanned image.




PrecisionScan Pro software displays a toolbar containing 
 buttons for common commands.

"��
������!������������!

To make resetting resolution o
Reset Resolution tool and the 

��
���
	����
	�
	��
	������
1 On the Tools menu, click C

2 When the dialog box open
dialog box, and click and h

3 Drag the cursor to a locatio
button.

s button To

New Scan Start (preview) a new scan.

Scan To... Perform a final scan and send to a destination, 
such as e-mail.

Save As... Save the selection area as a file.

Print Scan and print the selection area.

Return To... When using TWAIN or WIA, return the scanned 
image to the other program.

Copy Scan and place the selection area on the 
Clipboard.

Zoom In Zoom in on the selection area.

Zoom Out Zoom out to the original view.

Rotate Left 90 Ro

Rotate Right 90 Ro

Undo Editing 
Changes

Re
def

Guided Steps Sh

Context Help Dis
sof
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The in
the fol

A the

B the

C sc

D the

E the

lowing information:

n you can take when the pointer is over 
software window or a tool.

y adapter when it is in use.

s when the scanner is scanning or the 
cessing a command.

ytes), MB (megabytes), GB (gigabytes), 
image in the selection area. This size is 
ctual size of the saved file, which 
sed to save the file. The file can be 

e value shown here.
�


fo bar appears at the bottom of the preview window and displays 
lowing information:

 width of the output image

 height of the output image

ale of the output image

 Output Type currently selected

 Help button for HP PrecisionScan Pro software

���������


The status bar displays the fol

A A message about the actio
some part of the scanning 

B An icon for the transparenc

C One of the following:

● A progress bar that show
scanning software is pro

● The number of KB (kilob
or TB (terabytes) in the 
only an estimate of the a
depends on the format u
larger or smaller than th
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�����

The sha
in the sc

Selection

New s
area

Move 
area

Resiz
area h

Resiz
area v

Resiz
area d

Drop a

Drop n

k a menu item and select a command.
k a list button to select an option.
k a button to turn it on or off, or to increase or 
rease a number.

k, then type a value.

ition this cursor over a light area in the image to 
 its pixel value in the RGB meter and the 
ogram. Click on pixels to set them as the 
hlight value. In the Transparency Exposure 
stment tool, click to set the RGB value.

ition this cursor over a dark area of the image to 
 its pixel value in the RGB meter and the 
ogram. Click on pixels to set them as the 
dows value.

cates this area is an area in which pixel value is 
available.

k on a tool, field, button, or menu item for pop-up 
 on that item.
to TOC

&�3����
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1����
��
�

pe of the pointer indicates the type of activity you can perform 
anning software.

 area cursor

election Draw a new selection area.

selection Drag the selection area to a new location in the 
preview area.
Drag the selection area to another program.
Press CTRL and drag the selection area to the 
Windows desktop or a folder in Windows Explorer.

e selection 
orizontally

Appears over handles on the sides of the selection 
area. Drag the cursor to resize the width of the 
selection area.

e selection 
ertically

Appears over the handles on the top or bottom of 
the selection area. Drag the cursor to resize the 
height of the selection area.

e selection 
iagonally

Appears over handles on the corners of the 
selection area. Drag the cursor to resize both the 
height and width of the selection area.

llowed The program or folder the image has been dragged 
to accepts this kind of drop.

ot allowed The program into which your are trying to drag the 
image does not accept this kind of drop.

Ready cursor

Ready for activity Clic
Clic
Clic
dec

Typing cursor

Data entry 
accepted

Clic

Pixel value cursor

Highlight 
eyedropper

Pos
see
hist
Hig
Adju

Shadow 
eyedropper

Pos
see
hist
Sha

Eyedropper and 
the “no” symbol

Indi
not 

What’s This? Help cursor

What’s This? Help Clic
Help
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�

a b c d

6"��	
��
Used to
images 

78"��	
�
Color im
combine
colors. T

79:
��
The pale
the imag

79:
��
A palette
are stan

or Windows bitmap images. See also 

 common bitmap format for Windows 

or FlashPix files. 

phics Interchange Format files.

pertext Markup (HTML) files. This 
l.

EG files.
to TOC
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 e f g h i j k l m n o p q r s t u v w x y z

�������
 represent black-and-white photos accurately. These grayscale 
contain 256 shades of gray.

����
ages composed of three 8-bit color channels. When 
d, the red, green, and blue channels provide up to 16 million 
his is also referred to as true color.

���
+��	�
����
����		�,
tte for this image comprises the 240 most common colors in 
e plus the 16 basic colors.

���
+���
����		�,
 or color table containing red, green, and blue pixel colors that 

dard for images embedded in Web pages or .html files. 

4�
�
The filename extension used f
Windows bitmap.

4���
Device Independent Bitmap. A
programs.

4��!
The filename extension used f

4���

The filename extension for Gra

4�	

The filename extension for Hy
extension also appears as htm

4.��
The filename extension for JP
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4��!
The fil

4���
The fil

4���
The fil

4�	�
The fil

4	��

The fil

4	!	

The fil

4�
�

The fil

�

�� ���
A com
Acquir
then re

 using or that is currently selected. A 
lor to distinguish active from inactive 

er.

pter.

 angled lines or object edges that result 
een pixels. Seen in both black-and-

s. Sometimes called ‘jaggies’.

sitions between pixels, reducing the 

ace a scan would require if saved to 
ize value does not apply if the Output 
; it only applies to an image 

nly the item(s) detected on the scanner 
g area.
ename extension for Paintbrush files.

ename extension for Portable Document Format (PDF) files.

ename extension for Portable Network Graphics (PNG) files.

ename extension for Rich Text Format files. 

ename extension for TIFF or TIFF compressed files. 

ename extension for plain text files.

ename extension for Windows metafiles.

�
mand offered by programs that support TWAIN. Selecting 
e takes the user directly to a selected scanning software, and 
turns the scanned image to the requesting program. 

��	�#�
������

The program you are currently
program’s title bar changes co
programs.

1'(

See automatic document feed

1�	�#�
5�1
Or XPA. See transparency ada

��������
The visibly jagged steps along
from sharp tonal contrasts betw
white images and color image

��	�"��������
A technique that smooths tran
jaggedness of curved lines.

�����!�
�	�
����
Reflects the amount of disk sp
your computer. Approximate S
Type for the scan is set to text
representation of the scan.

��	�+
�	��,
��������
Automatic cropping displays o
bed, not any of the surroundin
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��	�
�
Abbrevia
multiple

1�	�+
�
A featur
optimal 
resolutio
is select
type.

�

��	
���	
The num
image. A
provides
indexed
24-bit im
the large

��	
��
A type o
matrix o
bitmap, 

�����"��
Black-an
pixels, n

es are black-and-white images made up 
e images must be saved as .wmf files.

ool lets you change the dividing point for 
age that uses the Black & White Bitmap 

below the threshold will be output as 
 threshold will be output as white.

 image indicating scanning boundaries. 
election border and handles that are 
gion.

) and dark (shadows) in an image. In 
wer the brightness, the closer the image 
 brightness, the closer the image will be 
t be confused with contrast, which 
the darkest and lightest shades in an 
 the intensity of shades in an image, 
number of shades in the image.

ouse button once. Right-click means to 
use button once.
to TOC
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������
ted ADF, it is an optional accessory that allows users to scan 

 pages.

	��,
������	���
e of the scanning software that automatically applies the 
output resolution to the selection area. For example, output 
n is automatically set to 200 when the True Color output type 
ed, and set to 300 for the Black & White Bitmap (raster) output 

�
ber of bits used to define the shade or color of each pixel in an 
 1-bit image is black and white. An 8-bit grayscale image 
 256 shades of gray. An 8-bit color image provides 256 
 colors and is associated with a specific palette or color table. A 
age provides over 16 million colors. The greater the bit depth, 
r the size of the saved file. See also file size.

f black-and-white, gray, or color image or picture made up of a 
f individual pixels or dots. Often referred to as raster, raster 
or raster image. 

�"���	�
��	
��
d-white raster bitmaps contain only black pixels and white 
o colors or shades of gray. Each pixel represents one bit.

�����"���"���	�
��������
Black-and-white scalable imag
of lines rather than dots. Thes

/����
0
���	�
���������
	���
The Black & White Threshold t
black-and-white pixels in an im
(raster) output type. All pixels 
black, and all pixels above the

������
A line surrounding the scanned
Clicking the image reveals a s
used to define the scanning re

�����	����
The balance of light (highlights
black-and-white images, the lo
will be to black. The higher the
to white. Brightness should no
measures the range between 
image. Brightness determines
while contrast determines the 

�

�����
To press and release the left m
press and release the right mo
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Pixels
would

�3;<
Cyan,
compo
pigme

���#�
Text th

�����

The pr
range.
that in

�����

The re

�����

The pr
device

�����

The nu
monito
colors
higher

balance and hue.

mpressed. A bitmapped file format for 
to 24-bit depth images. TIFF file format 
mages and is supported by many 
pressed TIFF files use data 

e of the resulting file. Compressed TIFF 
e extension .tif.

just settings that determine how the 
 software perform operations.

s questions related to the currently 
ovided in five ways: Text Labels, 
tatus bar messages, and Help 

t and darkest shades in an image. An 
ew gray shades between black and 
ated by stark light and dark tones. An 
ny shades of gray and tends to look flat 
g the highlight, shadow, and midtone 
�
��!���
 in an image that are extremely light or extremely dark and that 
 lose detail when the image is printed or displayed.

 Magenta, Yellow, Black. The color model in which all colors are 
sed of Cyan, Magenta, and Yellow, the primary colors of 

nts like ink, plus Black. Printers use CMYK to print in color.

�	��
	�!	

at has been rendered into digital format by an OCR program.

�������

eservation of balance between colors throughout the tonal 
 Color balance is particularly important when scanning objects 
clude neutral tones (grays) or large areas of consistent color.

�������

d, green, and blue components from which colors are created.

������	���

ocess of adjusting an image to compensate for input and output 
 characteristics or color flaws in the original image.

���	�
mber of colors that a monitor can display at once. Most PC 
rs display 8-bit color (256 colors), 16-bit color (about 65,000 

), 24-bit color (about 16 million colors), and 32- bit color. The 
 the color depth, the more lifelike images look on screen.

�����
�����

A tool used to adjust the color 

��
�������
��((

Tagged Image File Format, co
images, capable of storing up 
is recommended for scanned i
programs and computers. Com
compression to reduce the siz
files are saved with the filenam

���������

A feature enabling users to ad
scanner buttons and scanning

���	�!	"�����	�#�
����

Context-sensitive Help answer
displayed topic. The Help is pr
ToolTips, What’s This? Help, S
commands. 

���	���	

The range between the lightes
image with high contrast has f
white and appears to be domin
image with low contrast has ma
and dull. Change contrast usin
settings.
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�
This ran
compen
adjustm
control i
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To elimin

��		����
Saving s
scanned
future. 

�

������	
�
Predete
the beha
software
Black & 
default s

�����	�

The abil
density 
to both b

nwanted pattern, such as a moire 
ed original so the pattern does not 

 device where the scanned image will be 
ter, a Web page, or an e-mail program.

 to communicate with devices, such as a 
nner.

mputer monitor can display both 
en resolutions are typically 640 x 480 

), or 1024 x 786.

pixel colors when reducing the color 
an improve transitions between colors 
to 8-bit format.

main program window.

entation, document refers to an original 
t and images. It also means an original 
atic document feeder.
to TOC

����
ge determines the number of bits used for exposure 
sation, shadow detail, and black-and-white threshold 
ent displays. The higher the bit depth the finer the level of 
n adjusting these image manipulation functions.

ate portions of an image from the final scan. 

ettings allow users to save a set of settings used with one 
 image and reuse the settings with an image scanned in the 

�		����
rmined settings in the scanning software that define levels on 
lf of the user. Default settings in the HP PrecisionScan Pro 
 are set for Output Type, Output Resolution, Color, Exposure, 
White Threshold, and Sharpen Level. Users can override 
ettings.

ity of a material to absorb or transmit light. The greater the 
of a material or object, the more black it contains. This applies 
lack-and-white images and color images.

��������
The process of removing an u
pattern, that appears in a print
appear in the scanned image.

���	���	���

The file, program, or hardware
used. Examples include a prin

��#���
���#��

Software that the system uses
display, printer, mouse, or sca

�������
������	���

The number of pixels that a co
horizontally and vertically. Scre
(VGA), 800 x 600 (super VGA

��	������

The process of approximating 
depth of an image. Dithering c
when reducing a 24-bit image 

����

To attach a tool window to the 

����
��	
For the purposes of this docum
item containing text or both tex
item scanned using the autom



118 Back to TOC

��	�"�
See d
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To pre

���
Dots p
are us
printed
greate

����
To mo
select
to mov

����"�
To mo
object
anothe
droppi
receiv

����"�
A list o
comm

canned image into characters you can 
other text-editing program. Depending 
ram, you can change the font, size, 
itable text, as well as edit words or 

 transfer messages and electronic files. 
 browsers. 

 format for use in other programs.

ess and contrast, in an image. 

saved. Certain file formats enable 
sors to insert, open, or import scans. 

lude .bmp, .jpg, and .tif. Common text 
rtf (Rich Text Format). 
��"����

pi.

"�����

ss and click a mouse button twice in rapid succession.

er inch. The number of dots in a linear inch. DPI measurements 
ed to describe the resolution of printers and scanners, where 
 images and words are made up of a series of round dots. The 
r the DPI number, the higher the resolution.

ve an object on screen. Place the cursor over the image or 
ion area, hold the left mouse button down, and move the mouse 
e the object.

��"����

ve an object to a new location and keep it there. Click on the 
 and drag it to a new location, such as an open document in 
r program, and release the mouse button. When dragging-and-

ng between programs, a copy of the object is placed in the 
ing program.

���
���	
+��

���,
f items that appears when you click on or pass the cursor over a 
and such as File or Edit.

�

���	����
	�!	

Text that is converted from a s
modify in a word processor or 
on the capabilities of your prog
style, and other attributes of ed
phrases.

�"
���

A network over which you can
E-mail is also sent via Internet

&!���	
To save a file in a particular file

�!������

The amount of light, or brightn

�

����
���
�	
The format in which a scan is 
programs such as word proces
Common graphics formats inc
formats include .txt (text) and .
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FlashPix
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The Flow
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The Fra
as close
Text ma
expand 

�����

Refers t

anner hardware containing the buttons 
ation or changing settings.

id-level grays or midtones of an image. 
ge allows you to change the brightness 
ray tones without dramatically altering 

his applies to both black-and-white 
 default setting of 2.2 ensures integrity 

photographs in which individual pixels 
reas of white between them, thus 
 quality of the image. Graininess can 
uality original or reduce the bit depth of 
g or halftoning.

ported by many Windows programs. 
ort 256 colors. Graphics Interchange 
 filename extension .gif.
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ber of bytes in a file. File size of scanned images is 
ed by resolution, file type, output type, and scaling. To reduce 
ize of photographs, for example, you could decrease bit depth 
tion. 

�

al image, defined by the selection area, that is sent to a 

ion such as a file, a printer, the Clipboard, or another program. 

�

roximate height and width of the final image to be scanned. 



t that allows faster processing, but creates larger file sizes. 
 files, which save with the .fpx extension, can be used on 

s and Macintosh platforms. The format was developed by 
Packard, Kodak, Live Picture, and Microsoft.

�!	
ed Text option converts output into one column, placing 

as closely as possible to the appropriate text.

	�!	
med Text option places text and images in a frame, positioned 
ly as possible to the way they appear in the original document. 
y be more difficult to edit extensively since the frames may not 
to hold additional text.

o the sharpness of an image.

����	
�����
The area on the front of the sc
for sending an item to a destin

�

��

�

The contrast that affects the m
Adjusting the gamma of an ima
values of the middle range of g
the shadows and highlights. T
images and color images. The
among computer systems.

������

Refers to images, pictures, or 
are relatively large and have a
reducing the overall perceived
occur when you scan a poor-q
the scanned image by ditherin

)�������
��	��������
(��
�	
A graphic file format that is sup
Files saved in this format supp
Format files are saved with the
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Histog
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��
the scanner across the network.

mber of copies, destination printer, and 
 selects the Copy option on the scanner.

 provides for previewing an image 
n; making changes, such as resolution, 
ing images as files.

n that starts the HP PrecisionScan Pro 
nScan Pro software.

ds scanned images directly to a 
are available only in English.

A language used in creating documents 
ments can be saved in HTML format 
n.

f a visible color that enables you to 
. Six hues are especially important in 
inting: red, yellow, green, cyan, blue, 
ed by the frequency of the wave of light 
 saturation.
���

ginal or output type containing shades of gray, not just black and 
 In a grayscale image, each pixel contains multiple bits of 
ation, allowing more shades of gray to be recorded and 
yed. Four bits can reproduce up to 16 levels of gray, and eight 
n reproduce 256 shades of gray. Grayscale is commonly used 
ck-and-white original photographs but is also effective in 
ining shading in pencil drawings. 

�

inal composed of a pattern of dots that tricks the eye into seeing 

s of gray or color. Halftones are common in all printed materials. 
ing halftones instead of photographic originals can result in 
final image quality.

rtical dimension of a scan as it will appear at its destination.

�	�

htest portion of an image, usually reproduced as white on the 
ter screen or when printed. 

��


hical representation of the concentration of pixels at each 

ity or gray level in the selection area of the scanned image. 
rams help determine the optimal highlight, shadow, or threshold 
of an image. 

��
�������������
-12
���	��
Utility that allows users to use 

��
����=�	
����
>	���	�

The software used to select nu
other copy options after a user

��
�������������
���
���	����
The scanning software that HP
before sending it to a destinatio
resizing, and contrast; and sav

��
��������
���	����
The name of the scanner butto
software. See also HP Precisio

��
�����"	�"���

An automated feature that sen
destination on the Web. Links 

��3-

HyperText Markup Language. 
for the World Wide Web. Docu
and will have an .htm extensio

���

The distinctive characteristic o
distinguish it from other colors
photography, scanning, and pr
and magenta. Hue is determin
that creates the color. See also
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�
���
�
The size
bar. File

�
���	
To bring

����
���
A form o
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percenta

��	�����
Resoluti
hardwar
able to e
for enlar

resolution of an image by the addition of 
ge, the colors of which are based on 

ge (for example, in a black-and-white 
white and white areas are turned black). 

ollage, etc. you place in the scanner to 
referred to as an image or scanned 

 between black and white, or areas of 
ged edges can be avoided by scanning 
r output device, or by not scaling the 

oup. A compressed file format that 
aster file access. This format can reduce 
 when the file is decompressed and 

 saved with the filename extension .jpg. 
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ronic picture that can be displayed on a computer screen or 
 a disk. 

��	��
ram that lets you modify bitmapped drawings and photographs.

���

 of the image expressed in bytes and displayed in the Status 
 size and image size may vary, depending on the file type.

 a scanned image into a document from another program.



f assistance that appears in the lower, left corner of the screen 
lays the width and height of the output image, the scale 
ge, the Output Type currently selected, and a Help button.

�	��
������	���

on that is changed in the scanning software rather than in the 
e. For example, if your scanned image is 600 dpi, you might be 
nhance it to 1200 dpi in the scanning software. This is useful 
ging small images.

��	������	���

The process of increasing the 
new pixels throughout the ima
neighboring pixels.

��#��	

To reverse the colors in an ima
image, black areas are turned 

�	�

The physical drawing, photo, c
scan. Once it is scanned, it is 
image.

9

.�����

Refers to the uneven transition
color, in a scanned image. Jag
at a higher resolution than you
image after scanning it.

=�&)

Joint Photographic Experts Gr
reduces file size and enables f
image quality and performance
recompressed. JPEG files are
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softwa
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graysc
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The gr
70% b
image
proper
the im

r printing that results from incorrect 
alftones. Moire patterns usually result 
n you scan images taken directly from a 

an image in an image editor after it is 

 optional transparency adapter that is 
Negatives are then placed in the 

(unwanted specks) in an image by 
o minimize the effects of noise in the 

ion.

y that recognizes letters in a scanned 
ASCII characters, or editable text.
���
����	��	�

troke or combination of keystrokes that allows you to quickly 
plish common tasks.

���

ientation of a photograph or image that is wider than it is tall. 
 an image is taller than it is wide, it is called portrait orientation.

�

��!��
���	�
ption enables higher bits per pixel when the scan is sent to the 
re. When it is off, 8 bits per pixel are returned for grayscale and 
for color. When it is turned on, 16 bits per pixel are returned for 
ale and 48 bits for color. 

��

ay shades of an image. Midtones are usually between 30% and 
lack. Midtone control adjusts the brightness of gray levels in the 
 so that the lightest and darkest portions of the image can be 
ly displayed on your monitor. The higher the setting, the brighter 
age appears on your monitor.


����

An undesirable pattern in colo
screen angles of overprinting h
when you scan a halftone, whe
magazine, or when you scale 
scanned.

�

����	�#�
	�
���	�

The cutout that comes with the
placed on the scanning glass. 
template.

�����
�����	���
This option reduces the noise 
applying software algorithms t
scanner electronics.

�

$�%

See optical character recognit

��	����
������	��
�������	���
Abbreviated OCR. A technolog
image and converts them into 
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The orig
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The file 
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�
The actu
the size
affects o
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The type
type rev

sion) supported by MS-DOS, Windows, 
d numerous programs. Paintbrush files 
ve a maximum image size of 64,000 by 

able that establishes the colors that can 
 a particular time. The only color depth 
 the 256 (or 8-bit) color setting for your 
6 colors, each program (or even each 
d in a program) can have a different 

 your monitor is set to a color depth of 
grams. When you switch programs, the 
ecomes the system palette, and all other 
s accurately as possible with the new 

ic documents to someone’s fax 
lso allows receiving of faxed documents 
x machine.
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�����	���

 resolution of a scanner, the resolution at which the scanner 
 images. See also: interpolated resolution, resolution. 

�
����		�

 or color table that contains the pixel colors present in an 



inal document or picture to be scanned. 

that is generated by the scanning process.

�
�������

al height and width of an image when saved. You will not see 

 changes to your image in the Preview area since image size 
nly the final scan.

���

 of file that is generated during the scanning process. Output 

eals the bit depth of the image.

(

����	�����

A bitmap file format (.pcx exten
UNIX, and other platforms, an
support 24-bit color and can ha
64,000 pixels.

����		�

A subset of the color look-up t
be displayed on the monitor at
that allows multiple palettes is
monitor. At a color depth of 25
individual image used or edite
color palette.

����		�
��������

The flashing that occurs when
256 colors and you switch pro
palette of the active program b
programs redraw themselves a
colors.

��
��!
������

A program for sending electron
machine or PC fax program. A
to the computer instead of a fa
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suitab
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���	��
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image

���	��
Term f

���

Pixels
scann

������
Refers
scann
the loc
during
time th
scann

ed image so you can view it in the 
en select an area to be saved; make 
and size; and save the final image.

ftware where the scanned image is 

 of dots per inch (dpi) the printer is 
er printers have resolutions of 600 dpi, 
tions of 300 dpi for photographs and 600 
 have resolutions of 1200 or 2400 dpi. 
oother the output and the greater the 

d colors the device can describe.

overview of the scanner’s capabilities 
mpleted. It appears each time the 
s it is specifically disabled. It is also 

, or color image or picture made up of a 
ts. This is also referred to as a bitmap.
allest element (picture element) that can be assigned an 
ndent color and intensity and can be displayed on a computer 
. Pixels are square dots arranged in a grid pattern to make up 

ages displayed on the screen.

le network graphics format. A compressed image file format 
le for the Web that might replace GIF because of copyright 
 with GIF format. PNG is non-lossy compressed, supports 
cing, and can be used with the True Color output type, which 
nnot.

�	

ation of a photograph or image that is taller than it is wide. An 
 that is wider than it is tall is called a landscape orientation.

�
�����
or scanning items directly to a website.

 Per Inch. A measurement of resolution for monitors and 
ers where the individual element is a square pixel.

�����
 to a user’s preferred method of using the scanner. The 

ing software automatically saves certain preferences, such as 
ation of toolbars and the destination of a scan, that it detects 
 normal use of the scanner. Some preferences are restored each 
e scanner is used, others are maintained only throughout a 

ing session.

���#���

A feature that displays a scann
scanning software. You can th
adjustments to the tone, color 

���#���
������
The rectangular area in the so
displayed.

����	��
������	���

A measurement of the number
capable of printing. Typical las
typical ink printers have resolu
dpi for text, while imagesetters
The more dots per inch, the sm
number of grayscale levels an

������	
����
The Product Tour provides an 
and how scanning tasks are co
scanning software starts, unles
available in the Help menu.

/




���	��

A type of black and white, gray
matrix of individual pixels or do
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Red, Gr
of a vary
primary 
monitor.

����
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A forma
original 
compati
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To press

��	�	�
	�
To rotate
counterc

ific hue. An image with high color 
ack-and-white photograph has zero 

ical size of an image while maintaining 
rizontal dimension to the vertical 

ph, or text as a digital electronic image 
o refers to the image that has been 

clude the flatbed, transparency-slides, 

er where you place items to scan. 
canner glass.

ner where you place items to scan. 
canner bed.
to TOC

�

sure of how many dots per inch (dpi) are scanned, displayed, 

d. The greater the dpi the greater the amount of detail that is 
nd the larger the file size. The final output device (monitor, 

for a scanned image determines the resolution of the image. 
ple, if you scan a picture at 600 dpi (the optimum) and your 

 capable of printing at only 300 dpi, the printed image will be 
 than 300 dpi.

een, Blue. The color model in which every color is composed 
ing amount of red, green, and blue, which are the three 
colors of light. RGB is used to display colors on a computer 
 


���
�	

t for text files. Rich text format preserves all formatting in the 
text document. It converts formatting into instructions that 
ble programs can interpret. Rich text format files are saved 
 filename extension .rtf.

�

 and release the right mouse button once.

��

 the entire scan 90 degrees clockwise or 90 degrees 
lockwise.

�

��	���	���

The intensity of color in a spec
saturation has vivid color. A bl
saturation. See also hue.

�����

To reduce or increase the phys
aspect ratio (the ratio of the ho
dimension).

����

To capture a picture, photogra
using a scanner. This term als
scanned.

��������
������

Scanning (or scan) sources in
and transparency-negatives.

�������
���

The glass surface of the scann
Sometimes referred to as the s

�������
�����

The glass surface on the scan
Sometimes referred to as the s
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The pr
TWAIN
HP Pr

arge areas of color in a scanned image 
the area.

askbar that can be used to start a 
nge settings, and open documents. 

t Windows program screens that shows 
ction in progress.

ing a Web palette plus more shades of 

e of the Windows Desktop. The Taskbar 
ns for each open program, and a status 

s saved in the following formats: .txt, 
��
���
, or cover, of the scanner, which holds the original paper flat for 

ing.


������	���

easurement of the number of lines per inch (lpi) that a screen 
splay. This is usually 75 lpi.

Computer System Interface. An interface that lets you attach 
isks and other high-performance peripherals to your computer.

��
����

ea inside the rectangular border drawn around a portion of the 
 in the Preview area. The selection area is scanned when you 
nd-drop, save to a file, copy to the clipboard, or print.

�

rkest area of an image, usually reproduced as near black on the 
ter screen or when printed. The range between highlight and 

w determines the quality and color differentiation in the image. 

�

ance the detail in an image. 



ogram from which an image is retrieved for use in a document. 
-compliant programs pull an image from a source, such as the 

ecisionScan Pro software.

���	
�����

A software function that finds l
and applies a uniform color to 

�	��	
��		��

The button in the (Windows) T
program quickly, find files, cha

�	�	��
���

The area at the bottom of mos
information about the current a

���	�

����		�

A palette or color table contain
gray and the 16 VGA colors. 

�

�������

A toolbar that docks to the edg
includes the Start button, butto
area. 

	�!	
As it relates to scanning, text i
searchable .pdf, .htm, and .rtf.
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A brief d
control (
window.
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Abbrevia
transpar
into the 
above th


��	
 Pro software for adjusting the Midtones 
dows for transparencies, negatives, and 

 with 24-bits per pixel per color.

ications protocol for sending instructions 
r) and receiving data back from them 

 using a program that supports TWAIN, 
Scan Pro software directly from that 

king an image proportionately in both 
ctions. 

ace for connecting peripherals, such as 
to TOC

����

cess of rendering all areas darker than a set value as black, 
reas lighter than a set value as white. Useful when converting 
le images to black and white. 

Image File Format. A bitmapped file format for images, 
 of storing up to 24-bit depth images. TIFF file format is 
lly appropriate for scanned images and is supported by many 
s and computers. TIFF files are saved with the filename 
n .tif.

rall effect produced by the combination of lighting, shade, and 

a that contains buttons for an program’s controls.

escription that appears when the mouse pointer pauses over a 
such as a menu item or toolbar button) in a software program’s 

�����
����	��
ted as XPA. An optional accessory used to scan 

encies, negatives, and slides. An XPA connector is plugged 
scanner, and a template is used to position the transparency 
e glass.

������������
�!������
��.��	
A tool in the HP PrecisionScan
(contrast), Highlights, and Sha
other transparent media.

	���
�����

An image type that is rendered

��1�2

An industry-standard commun
to hardware (such as a scanne
(such as an image). If you are
you can start the HP Precision
program.

�

������

�������

A method of stretching or shrin
the vertical and horizontal dire

>�/

Universal Serial Bus. An interf
scanners, to a computer.
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Windo
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The ho
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A bitm
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color. 
.bmp.

color and used to store and exchange 
-based programs. Windows metafiles 
tension .wmf.

ify, the image in the Preview area so 
ade to the image. This action does not 

d, printed, copied to the clipboard, or 
.



 of image that uses algebraic equations to define the various 
nd curves of the image. 

���		�

tte or color table containing red, green, and blue pixel colors that 
dard for images embedded in Web pages or .html files. It 
ts of 216 entries of all combinations of the values 0, 51, 102,153, 
nd 255.

�
�����	
ws Imaging Architecture. The method Word uses to bring 
ed images into an open Word document. Similar to TWAIN.

rizontal dimension of your scan as it is sent to its destination.

��
��	
��

apped file format for pictures, supported by most Windows 
ms. Windows bitmap files support 1-, 4-, 16-, 24- and 32-bit 
Windows bitmap files are saved with the filename extension 

�������

�	�����

A file format supporting 24-bit 
image data between Windows
are saved with the filename ex

&

5�1
See transparency adapter.

$

7

���

����

The ability to enlarge, or magn
that finer adjustments can be m
enlarge the picture that is save
dragged into another program
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characters, incorrect 89

checklist, troubleshooting 79
cleaning

ADF 100

ADF window 101
scanner 99
XPA 100

clearing ADF jams 97
click, definition 115
clipped pixels

checking for 46
definition 116

CMYK, definition 116

collating copies 20
color balance

adjusting 49

definition 116
color channels

changing 51

definition 116
color copies

button for 16

making 20
color correction

automatic 61

definition 116
highlights, adjusting 44
hue, adjusting 49

midtones, adjusting 43
saturation, adjusting 49
shadows, adjusting 45

color depth
definition 116
output types 36

color images
output types for 36

color wheel
adjusting hue 49
definition 116

colored paper
adjustments for 51
copying from 86

colors
automatic adjustment 61
converting to black and white 51
���
P PrecisionSca
 cleaners, avo
ries

 65
y, OCR 23
g scans 63

rogram, definiti
, transparency.
tomatic docum
ity 96

ing 100
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g problems 96
 clearing 97
 preventing 96

g 66
dialog box 66
ing from 66

eshooting 96
dow

ing 101

ing 102
lack & White T
uts 107
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uts 107

 49
xposure comm
uts 107

 43, 44, 45
 for transparent
g
rounds 47
and white thres
ness 43

channels 51
st 39

hts 44
9
nes 43

t levels 47
rences for scan
ences for scan
n Pro command 108
iding 99

on 114
 See XPA
ent feeder)

ns 7

hreshold command

and

 items 73

hold 50

ner buttons 24
ning software 60

saturation 49

shadows 45
tonal resolution 62

Adobe Acrobat Reader 55

 See also .pdf files
Advanced menu, shortcuts for 107
alarms, highlight and shadow 46

alcohol, cleaning with 99, 100
alerts

highlight 46

shadow 46
Smart Friends 32

aliasing, definition 114

anti-aliasing, definition 114
approximate size

definition 114

files 110
areas, selecting

automatic 61

using cursor 34
ASCII text, saving as 55
attaching files to e-mail 17

automatic cropping
definition 114
settings 26

automatic document feeder. See ADF
automatic exposure adjustment 61
automatic resolution 115

Automatically Set Type option 36

B
backgrounds, adjusting 47
balance, color

adjusting 49

definition 116
bed, scanner

definition 125

printing entire 56
selecting entire 35

best quality settings 60
bit depth, definition 115
bitmap files (.bmp)

definition 115
using 55

black and white bitmaps

adjusting colors in 51

definition 115
shortcut for 107

black and white copies
button for 16
making 20

black and white images
inverting colors 42
output types for 36

black and white scalable
definition 115
shortcut for 107

black and white threshold
changing 50
definition 115

black areas, adjusting 45

black eyedropper tool 45
black images, troubleshooting 85
black output levels, changing 47

blank pages, troubleshooting 85, 87
blue color channel 51
.bmp files (bitmap)

definition 115
using 55

books, scanning pages from 7

borders, selection 35
boxes

around slides or negatives 88

around text 22
brightness

adjusting 43

definition 115
bulbs, broken 88, 95
business cards, scanning 7

Button Manager, HP 82
Button Options dialog box 24
buttons. See scanner buttons

C
capacity, ADF 96
carbon paper, scanning 7
Change Resolution command

shortcuts 107
using 38

changing. See adjusting
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highlight
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settings for 29
using 22

editable text
accuracy of 23
creating using OCR 22
definition 118

languages 61
options for 29, 61
output types for 36

troubleshooting 89
Editable Text (OCR) option, shortcut for 107
8-bit grayscale, definition 113

E-mail button
identifying 16
settings for 25

using 17
E-mail Document button

identifying 16

settings 25
using 17

E-mail Photo button
identifying 16
settings 26
using 17

e-mailing scans
attaching files 17
file sizes 38

supported programs 18, 25
troubleshooting 91
using scanner buttons 17

Enable All Smart Friends 32, 108
Enable Scan Another Page Dialog 60
enabling sharing

host computer 76
remote computers 78

End Task 79

enhancing details 40, 45
Exit 106
exposure

automatic adjustments 61
definition 118

eyedropper tools
black 45
functions of 111
viewing RGB values 48

white 44
Index

s, adjusting 44
usting 49
 42

s, adjusting 43
s, troubleshooting 88
pes 36

ues, viewing 48
n, adjusting 49
, adjusting 45

oubleshooting 88
olution 62

hooting 85, 87

d file formats 55
d TIFF, definition 116

ion dialog box, opening 24

Help topics 108
nsitive Help
o Help, online
s 108, 109

 39
 116
ge, definition 117

b options 62
 text. See OCR
king
roubleshooting 86
hooting 91
 ScanJet Copy Utility 6

anner button 20
n
g 16

mand
s 106, 109

y, HP 6
d pasting
hortcut 109
ipboard 57
 color
ic 61
 116

s, adjusting 44

usting 49
s, adjusting 43
n, adjusting 49

shadows, adjusting 45
crooked images, troubleshooting 85
crooked pages, troubleshooting 96

cropping
automatic, settings for 26
definition 117

scanning area 34
Current OCR Language option 61
cursors

black eyedropper 45
context-sensitive 111
dragging and dropping 57

Ready 111
Selection Area 111
Typing 111

white eyedropper tool 44
customer support

resources for 104

customizing
preferences for scanning software 60
resolution values 61

scanner buttons 24
settings 59

cut off pages, troubleshooting 87

D
dark areas

adjusting 45
troubleshooting 84

darkening images 43

dashed boxes 88
decreasing

details for transparent items 73, 74

details in dark areas 45
details in light areas 44
saturation 49

default programs, changing 24, 89
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